
Overview

PicoZip is an easy to use archive utility for handling archive files in various formats such as .zip, .rar 
or .ace. An archive file typically contains many files within itself, in a compressed form. Archives allow 
you to “package” files into a single, smaller file which you can distribute to others or keep as backup. 
Most files available from the Internet are distributed as compressed archives to minimize download time 
and to keep related files together. Click here to learn more about archives. 

Key features:

· Easy and intuitive user interfaces
PicoZip features can be accessed using the standard interface, Wizard interface or through Windows 
Explorer (via shell extensions). PicoZip's user interface were designed to be intuitive and simple, 
making it extremely to use.

· Seamless Windows integration
PicoZip is tightly integrated with Windows Explorer, allowing you to carry out most commonly used 
operations from within Windows Explorer. You can also drag-and-drop files to or from Windows 
Explorer. Click here to learn more.

· Supports more archive formats
PicoZip supports extracting files from over 17 different archive formats (.zip, .rar, .ace, .jar …) and 
creating archives in 8 formats (.zip, .bh, .jar, …). Click to learn more.

· Strong 128/256-bit AES support
PicoZip allows you to protect sensitive data in ZIP files using strong 128-bit or 256-bit Advanced 
Encryption Standard (AES) encryption. Click here to learn more.

· Virus scanner support
PicoZip can be configured to work with most virus scanners available today. 

· Create self-extracting archive
PicoZip can create archives that can extract itself without the use of any other archive utility. This is 
useful for distributing archive files to others who may not have an archive utility, or may not know how 
to use one. You have the option to create self-extracting archives in 8 different formats. Click to learn 
more.

· Integrated archive files explorer
PicoZip comes with an integrated archive files explorer, allowing you to browse your computer for 
archive files or browse the folders within an archive. Click to learn more.

· Fast and easy backup
PicoZip comes with an easy to use backup feature that automates most of the backup task for you. 
Routine backups takes only two mouse clicks ! Click to learn more.

· Powerful batch operations
PicoZip allows you to carry out tasks like extract, add, repair, convert, test, etc. on many archives in a 
single operation. This saves you from having to do time consuming repetitive work. Click to learn 
more.

· Export files list
PicoZip can export archive file contents listing in 3 different formats : HTML, CSV (Excel) or plain text.



· Convert archive formats
PicoZip can easily convert archives from one format to another. Click to learn more.

· Email support
PicoZip can automatically created an archive and insert it into a new email ready to send in just three 
mouse clicks ! Click here to learn more.

· Favorites
PicoZip allows you to bookmark all your favorite folders and makes it really simple to browse them for 
archives. Click to learn more.

· Zip password recovery
PicoZip has a FREE add-on password recovery tool to help you recover lost or forgotten passwords 
from Zip files. Click to learn more.

· Repair Zip archives
PicoZip can repair damaged Zip archives. Click to learn more.

· Split Zip archives
PicoZip can split large ZIP archives into many smaller files, making it easy to store large ZIP archives 
into practically any media. Click here to learn more.

· Quick access tray tool
PicoZip's tray tool resides in the Windows tray area on your task bar, providing you with quick access 
to commonly used features. You can also run backups or open recently used archives from here. 
Click to learn more.

· Extensive help
PicoZip comes with an extensive context sensitive help system. If at any time, you have any problems
using PicoZip, just hit the F1 key and the relevant information will be shown to guide you.

We hope you enjoy using PicoZip. If you find this software useful, please support us by registering this 
product. You can read user testimonials here, or see reviews by independent publications here. 
Competitive comparison of PicoZip and WinZip is available here.

Awards Won by PicoZip
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Introduction to Archives

An archive is typically a group of files stored in a single file in compressed form. There are many different
formats for archives. They are all similar in terms of functionality, with the main difference being the 
compression method being used. You can identify the different archive formats of a particular archive by 
looking at the filename extension (the letters after the last dot, e.g. “.zip”).

Archive formats supported by PicoZip

PicoZip can create archives in 7 different formats:

· .bh : BlakHole archive
· .cab : Microsoft Cabinet
· .jar : Javasoft archive
· .lha : Lha archive
· .lzh : Lzh archive
· .tar : Unix tape archive
· .zip : Zip archive

In addition, PicoZip can extract files from 18 different archive formats:

· .ace : Ace archive
· .arc : Arc archive
· .arj : Arj archive
· .bh : BlakHole archive
· .cab : Microsoft Cabinet
· .gz : Unix GZip (gz/tar)
· .jar : Javasoft archive
· .lha : Lha archive
· .lzh : Lzh archive
· .mim : Multipurpose Internet Mail Extension
· .rar : Rar archive
· .tar : Unix tape archive
· .tgz : Unix Tar/GZ archives
· .uue : UUencoded files
· .war : Java Web Archive
· .z : Unix Compress archives
· .zip : Zip archive
· .zoo : Zoo archive

Please note that the above archive formats are natively supported by PicoZip,    no third party software is
required.

Self-extracting (SFX) archives

A self-extracting archive is an archive that is created as an executable (.exe) file, and has the ability to 
extract the files from within itself without the use of any third party archive utility. PicoZip can create self-
extracting archives in 8 different formats. Click here to learn more.

Benefits of using archives



· Save hard disk space
You may have many rarely used files in your hard disk which takes up a lot of space. By compressing 
them into an archive, you can save up to over 80% in hard disk space. 

· Save time and money
Compressing large files into an archive before sending it over the Internet saves you a lot of time and 
money, especially if you are using a slow connection (e.g. 56k modem).

· Simplify backup management
If you need to backup a set of files often, storing them in archives means you only need to manage 
one file for each backup, rather than making copies of entire folders.
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System Requirements

PicoZip requires a 32-bit Windows platform such as Windows 95, Windows 98, Windows NT 4.0, 
Windows ME, Windows 2000 or Windows XP to run. It will not work under Windows 3.x or any older 
version of Windows.

PicoZip can also make use of third party virus scanners to scan archives if available, but is not required 
for PicoZip to work.



Uninstallation

There are two ways to uninstall PicoZip. The easiest way is to click on the Uninstall PicoZip icon in 
Start Menu > Programs > PicoZip. 

The second method is to open the Windows Control Panel, double click on Add/Remove Programs, 
then double click on the PicoZip entry in the list box.



Quick Start Introduction

This quick start guide will show you how to perform the basic archive operations using the various user 
interfaces provided by PicoZip as listed below. 

If you are new to archive files, you may want to read the Introduction to Archives first. In addition to this 
help file, you should also take a look at our online illustrated manual at 
http://www.picozip.com/visualmanual/vguide.html. It gives you step-by-step instructions for common 
tasks, accompanied by illustrative screenshots to make learning PicoZip quick and simple.

· Standard Interface
This is the main PicoZip window that you see when you run PicoZip. Click here to learn more.

· Wizard Interface
The wizard built-in to PicoZip to simplify tasks for users who are not familiar with archive utilities. 
Click here to learn more.

· Windows Explorer
PicoZip provides shell extensions which integrates into Windows Explorer,    allowing you to carry out
most common archive operations from within Windows Explorer. Click here to learn more.

· Drag-and-Drop Interface
You can add files to an archive or extract files by simply dragging and dropping files to or from 
PicoZip. Click here to learn more.

Related topic:
Frequently Asked Questions



Quick Start : Standard Interface

Creating A New Archive

Method 1
1. In the PicoZip window, click the New toolbar button or choose New Archive from the File menu. 

The New Archive dialog box will appear.
2. In the New Archive dialog box, select the location where you would like your archive to be 

created and enter the filename you would like to use for your new archive. You can also choose 
the archive format for this new archive. After that, click the Create button. The Add dialog box 
will appear. 

3. In the Add dialog box, select the files that you want to add to your new archive and click the Add
button. To learn more about the Add dialog box options, click here.

Your new archive has been created. You can now view the contents of your archive in the main PicoZip 
window. You can now add more files to your archive by clicking the Add toolbar button or choosing Add 
files to archive from the Actions menu.

Method 2
1. Select the files or folders you want to archive from Windows Explorer or My Computer, then drop

it in the main PicoZip window. Note that PicoZip must have no open archive when you do this. 
The Add Options dialog box will appear.

2. In the Add Options dialog box, select the location where you would like your archive to be 
created and enter the filename you would like to use for your new archive. You can also choose 
the archive format for this new archive and set some other options. After that, click the OK 
button. To learn more about the Add Options dialog box, click here.

Your new archive has been created. You can now view the contents of your archive in the main PicoZip 
window. 

Extracting Files From An Archive

1. In the PicoZip window, click the Open toolbar button, or choose Open Archive from the File 
menu. The Open Archive dialog box will appear.

2. In the Open Archive dialog box, locate the archive you want to extract, then click Open. The 
contents of the archive will be displayed in the PicoZip window.

3. Click the Extract toolbar button or choose Extract files to … from the Actions menu. The 
Extract dialog box will appear.

4. In the Extract dialog box, select the folder where you want to place the extracted files and click 
the Extract button. To learn more about the Extract dialog box options, click here.

The files in the archive has been extracted. 

Other Quick Start Topics : 
Wizard Interface, Windows Explorer, Drag-and-Drop Interface



Quick Start : Wizard Interface

Start the PicoZip wizard by clicking the Wizard toolbar button or choose Wizard from the File menu. You
need to do this before proceeding with either of the following tasks.

Creating A New Archive

1. Select Create a new archive file and click the Next button.
2. Type the filename you want to use for your new archive (including the full path, e.g. “C:\Temp\

TestArc.zip”). Alternatively, you can click on the  Browse button to locate the directory in which 
you want to place your new archive, type the filename and click the Open button. After that, click
the Next button.

3. Now, click the Add Files button, then select the files that you want to add to your new archive 
and click the Add button. You can repeat this step as many times as necessary to add all the 
required files.

4. Click the Finish button to create the new archive.

You can now click the Close button to return to the PicoZip window, or click the Next button to perform 
another task.

Extracting Files From An Archive

1. Select Extract all files from an existing archive and click the Next button.
2. Click on the Browse button to locate the archive file you want to extract, then click the Open 

button. After that, click the Next button.
3. Now, enter the full path (e.g. c:\temp) to the folder where you want to place the extracted files. 

Alternatively, you can click on the Browse Folder button to locate the folder you wish to use.
4. Click the Finish button to complete the extraction.

You can now click the Close button to return to the PicoZip window, or click the Next button to perform 
another task.

Other Quick Start Topics : 
Standard Interface, Windows Explorer, Drag-and-Drop Interface



Quick Start : Windows Explorer Integration (Shell Extensions)

Please start Windows Explorer before proceeding with any of the following tasks. Note: You do not need
to run PicoZip before performing any of the following steps.

Viewing Archive Information

In Windows Explorer, you can view information about an archive by simply positioning you mouse cursor
over the archive file for about one second. A small tooltip window will popup to show you information 
such as: number of files in archive, unpacked size, compression ratio and file names of the files in the 
archive.

This allows you to get an idea of what the archive contains without having to actually open it using 
PicoZip.

Creating A New Archive

1. In Windows Explorer, select the files which you would like to add to a new archive, then right 
click them and choose Add to Archive … from the popup context menu. The Add Options 
dialog box will appear. 

2. In the Add Options dialog box, select the folder where you would like your archive to be created
and enter the filename you would like to use for your new archive. You can also set some of the 
archive options if desired. Click the OK button. Click here for more information on the Add 
Options dialog box.

Your new archive has been created.

Extracting Files From An Archive

1. Right click the archive file which you would like to extract, then choose Extract To … from the 
popup context menu. The Extract dialog box will appear.

2. In the Extract dialog box, select the folder where you want to place the extracted files and click 
the Extract button.

The files in the archive has been extracted.

Opening An Archive

In Windows Explorer, just double click an archive file to open it in PicoZip.

Adding Files to An Archive

1. Select the files you would like to add to an archive, then right click on them. After that,    choose 
Add To Archive … from the popup context menu. The Add Options dialog box will appear.

2. In the Add Options dialog box, choose the archive file which you would like to add the selected 
files to, and click the Save button.



Another way to add files to an archive while in Windows Explorer is to drag one or more files and drop it 
on an archive file to add them to the archive. 

Other Operations Available from the Context Menu

When you right click an archive file, there are several other operations that you can perform on it, such 
as:    scan for virus, convert archive format, test archive, make self-extracting executable file, compress 
and email archive and repair archive.    See the tutorial "Using Windows Shell Integration" for more 
information.

Other Quick Start Topics : 
Standard Interface, Wizard Interface, Drag-and-Drop Interface

Related topics:
Configuring Shell Extensions
Using Windows Shell Integration



Quick Start : Drag-and-Drop Interface

Adding Files To An Archive

1. In the PicoZip window, click the Open toolbar button, or choose Open Archive from the File 
menu. The Open Archive dialog box will appear.

2. In the Open Archive dialog box, locate the archive which you would like to add new files to, then 
click Open. The contents of the archive will be displayed in the PicoZip window.

3. Now, you can add files to this archive by dragging files from My Computer or Windows 
Explorer and dropping it on the PicoZip Window.

Extracting Files From An Archive

1. In the PicoZip window, click the Open toolbar button, or choose Open Archive from the File 
menu. The Open Archive dialog box will appear.

2. In the Open Archive dialog box, locate the archive which you would like to add new files to, then 
click Open. The contents of the archive will be displayed in the PicoZip window.

3. Now, you can extract files from this archive by dragging files from the PicoZip window and 
dropping it on the desired folder in Windows Explorer or on the Desktop.

Other Quick Start Topics : 
Standard Interface, Wizard Interface, Windows Explorer



File Menu

The following commands are available on the File menu:

· New Archive: Create a new archive. See tutorial.

· Open Archive: Open an existing archive. See tutorial.

· Close Archive: Close the currently open archive.

· Move Archive: Move the currently open archive to a different folder. See tutorial.

· Copy Archive: Make a copy of the currently open archive. See tutorial.

· Rename Archive: Rename the currently open archive. See tutorial.

· Delete Archive: Delete the currently open archive. See tutorial.

· Mail Archive: Email the currently open archive. See tutorial.

· Wizard: Show the wizard interface.

· Properties: Display the properties (file date, compression ratio, size, etc) of the currently open 
archive. See tutorial.

· Create Desktop Shortcut: Create a desktop shortcut to currently open archive.

· Export Content List: Export the content list of the currently open archive. You have a choice of 3 
formats for export: HTML, CSV (Excel) or Plain Text.

· Print Content List: Print the content list of the currently open archive.

· Exit: Close PicoZip.

Other Menus:
Edit, View, Actions, Favorites, Tools, Options, Help



View Menu

The following commands are available on the View menu:

· Show Explorer: Toggle open or close the built-in archive files explorer. See tutorial.

· Refresh: Refresh the content list for currently open archive.

· Comment: View the comment of the currently open archive (Zip format only). See tutorial.

· View Selected Files: View selected files in the currently open archive. See tutorial.

· View Last Output: View the output from the last command issued by PicoZip. (Only applies to 
certain commands)

· Sort: Sort the files in the currently open archive based on your selected criteria.

· Show Filter: Toggle show or hide the filter toolbar which allows you to filter the files in the currently 
open archive. See tutorial.

Other Menus:
File, Edit, Actions, Favorites, Tools, Options, Help



Actions Menu

The following commands are available on the Actions menu:

· Add files to archive: Add files to the currently open archive. See tutorial.

· Delete files from archive: Delete files from the currently open archive. See tutorial.

· Extract files to … : Extract files from the currently open archive. See tutorial.

· Virus Scan: Scan the files in the currently open archive using a virus scanner. See tutorial.

· Make .EXE File: Create a self-extracting archive. See tutorial.

· Password Protect: Password protect currently open archive. See tutorial.

· Test Archive: Test integrity of currently open archive. See tutorial.

· Split Archive: Split the currently open archive into multiple volumes. See tutorial.

· Check Out: Check out the files in the currently open archive. See tutorial.

· Install: Install the software contained in the currently open archive. See tutorial.

Other Menus:
File, Edit, View, Favorites, Tools, Options, Help



Favorites Menu

The following commands are available on the Favorites menu:

· Add to Favorites : Add the currently selected folder in the built-in explorer to favorites menu. See 
tutorial.

· Organize Favorites : Manage your favorites. See tutorial.

Other Menus:
File, Edit, View, Actions, Tools, Options, Help



Tools Menu

The following commands are available on the Tools menu:

· Convert Archive Format : Convert the archive format of the currently open archive to a different 
format. See tutorial.

· Uuencode : Uuencode the currently open archive. See tutorial. 

· Repair Damaged Zip Archive : Repair a damaged zip archive and recover as many files as 
possible. See tutorial.

· Recover ZIP Password : Runs PicoZip Recovery Tool to help you recover your password from a Zip
file. This command is only available if you have PicoZip Recovery Tool installed. See tutorial.

· Quick Backup : This sub-menu shows a list of available Backup Sets which you can click to perform
the backup. See tutorial.

· Manage Backups : Create, modify or remove Backup Sets. Also allows you to run many backups 
together. See tutorial.

· Batch Add to Archive : Use this to add a set of files to many existing archives. See tutorial.

· Batch Create Archive : Use this when you have many files which you would like to archive 
individually. See tutorial.

· Batch Convert Archive Format : Use this to convert many existing archive files with various 
different formats into a single archive format which you choose. See tutorial.

· Batch Delete from Archive : Use this to delete file(s) from many existing archives. See tutorial.

· Batch Extract : Use this to extract files from many existing archives. Each archive is extracted to 
their own subfolder. See tutorial.

· Batch Make .EXE : Use this to make self-extracting executables from many existing archives. See 
tutorial.

· Batch Test : Use this to test the integrity of many existing archives. See tutorial.

· Batch Virus Scan : Use this to scan many existing archives for virus. See tutorial.

Other Menus:
File, Edit, View, Actions, Favorites, Options, Help



Options Menu

The following command is available on the Options menu:

· Configuration: Change PicoZip settings to make it work the way you want. Click here to learn more.

Other Menus:
File, Edit, View, Actions, Favorites, Tools, Help



Help Menu

The following commands are available on the Help menu:

· Contents : Open PicoZip help file. 

· Quick Start : Display PicoZip Quick Start tutorial.

· Hints and Tips : Display hints and tips on how to use PicoZip.

· Search for help on … : Open search dialog box for PicoZip help.

· Check for New Version : Connects to PicoZip server to retrieve information on the latest version of 
PicoZip available for download. You must be connected to the Internet for this to work.

· Frequently Asked Questions : Display the PicoZip FAQ.

· Enter Registration Code : Show the dialog box for entering registration information. See tutorial.

· Ordering Info : Display instructions on how to purchase PicoZip.

· License Agreement : Display PicoZip license agreement.

· Homepage : Start your default web browser and show the PicoZip website.

· About PicoZip : Display general information about PicoZip, such as version, copyright, etc.

Other Menus:
File, Edit, View, Actions, Favorites, Tools, Options



Open An Archive

There are several ways to open an archive. You can click on the Open toolbar button or choose Open 
Archive from the File menu. When the Open Archive dialog box appears, locate the archive you want to 
extract, then click the Open button. The contents of the selected archive will be displayed in the PicoZip 
window. 

Another way to open an archive is to double-click an archive file in Windows Explorer. PicoZip will 
automatically start up, and show the contents of the archive file.

Tip! Recently opened archive files are listed at the bottom of the File menu. You can click on a listed 
archive to open it. You can also view this list of recently opened archive files by clicking on the small 
down-arrow beside the Open toolbar button.



Create a New Archive

There are several ways to create a new archive. Click on any of the following to learn more:

1. Create an archive using the standard interface
2. Create an archive using the Wizard interface

You can also create an archive from within Windows Explorer. In Windows Explorer, select the files 
which you would like to add to the new archive, then right click them. A popup context menu will appear 
which provides 2 add options as explained below:

· Add To Archive … : The Add To …  dialog box will be shown, allowing you to enter the filename for 
the new archive and to select the location where you want the new archive to be created. When you 
are done, click the Save  button. An archive file with the name you entered will be created at the 
location you specified and the files you selected are automatically added.

· Add To “ArcFileName.zip” : An archive file with the filename shown (ArcFileName.zip) will be 
created in the current folder and the files you selected are automatically added. If you selected a 
single file, its filename will be used for the archive file. If you selected more than a single file, the 
name of its parent folder will be used for the archive file.

Formats that PicoZip can create are : 
· .bh : BlakHole archive
· .cab : Microsoft Cabinet
· .gz : Unix GZip (gz/tar)
· .jar : Javasoft archive
· .lha : Lha archive
· .lzh : Lzh archive
· .tar : Unix tape archive
· .zip : Zip archive



Viewing Files In Archive

You can easily view any of the files stored in an archive by first opening it in PicoZip, then double click 
the file you would like to view in the main PicoZip window. PicoZip will open the file using its associated 
application. For example, when you double click a .doc (Microsoft Word) file, PicoZip will display that file 
using Microsoft Word. Executable files (.exe) are executed if you double click on it.

Another way to view files in an archive is to select one or more files, then click the View toolbar button, 
or choose View Selected Files from the View menu.



Extracting Files

Files can be extracted from archives in several ways. Click on any of the following to learn more:

1. Extracting files using the standard interface.
2. Extracting files using the Wizard interface.

You can also extract files from an archive without leaving Windows Explorer. In Windows Explorer, right 
click an archive file which you would like to extract. A popup context menu will appear which provides 3 
extract options as explained below:

· Extract To … : The Extract dialog box will be shown, allowing you to specify the folder where you 
want the extracted files to be placed. You also have the option to set some of the extraction settings. 
To learn more about the Extract dialog box options, click here.

· Extract Here : All the files in the archive will be extracted to the same folder as the archive, and any 
folders stored in the archive will be restored.

· Extract To ArchiveFilename\ : All files in the archive will be extracted to a subfolder which has the 
same name as the archive file, and any folders stored in the archive will be restored.



Adding Files to an Existing Archive

There are a few ways to add files to an existing archive.

Standard Interface
1. Start PicoZip, then open the archive file which you would like to add some files. 
2. Click on the Add toolbar button or choose Add files to archive from the Actions menu. The 

Add dialog box will appear. 
3. In the Add dialog box, select the files that you want to add to your archive and click the Add 

button. To learn more about the Add dialog box options, click here.

Wizard Interface
1. Start PicoZip, then show the Wizard by clicking on the Wizard toolbar button or choose Wizard 

from the File  menu.
2. Select Add files to an existing archive then click the Next button.
3. Click the Browse button to locate the archive file which you would like to add some files. After 

that, click the  Next button.
4. Now, click the Add Files button, then select the files that you want to add to your new archive 

and click the  Add button. You can repeat this step as many times as necessary to add all the 
required files. You can also add whole folders by clicking on the Add Folders  button. Please 
note that adding a folder will also add any files in its subfolders.

5. Click the Finish button.

Drag-and-Drop Interface
1. In the PicoZip window, click the Open toolbar button, or choose Open Archive from the File 

menu. The Open Archive dialog box will appear.
2. In the Open Archive dialog box, locate the archive which you would like to add new files to, then 

click Open. The contents of the archive will be displayed in the PicoZip window.
3. Now, you can add files to this archive by dragging files from My Computer or Windows 

Explorer  and dropping it on the PicoZip Window.

Windows Explorer
In Windows Explorer, you can drag one or more files and drop it on an archive file to add them to the 
archive. Click here to learn more about PicoZip Windows Integration.

Batch Add to Archive
If you have a set of files which you would like to add to many archive files, use the Batch Add to Archive 
feature to save time.

Please note that files can only be added to archives with the following format: 

· .bh : BlakHole archive
· .jar : Javasoft archive
· .lha : Lha archive
· .lzh : Lzh archive
· .tar : Unix tape archive
· .zip : Zip archive



Deleting Files in an Archive

In order to delete files in an archive, you need to open the archive using PicoZip. In PicoZip main 
window, select the files you would like to delete from the list of files shown. After that, either press the 
Delete key on your keyboard or choose Delete files from archive from the Actions menu. Click Yes 
when asked for confirmation.

To delete the entire archive, click here.



Scanning Files in an Archive for Virus

An archive file can be scanned for virus by opening it using PicoZip, then choose Virus Scan from the 
Actions menu. You can also scan an archive for virus by right clicking it in Windows Explorer, then 
choose  Scan Archive for Virus from the popup context menu.

Please note that you must configure a virus scanner in order to use this feature. Click here for 
instructions on how to configure a virus scanner. 



Convert Archive Format

This feature allows you to convert an archive from one format to another. To perform this operation, 
choose Convert Archive Format from the Tools menu. The Convert Archive dialog box appears. You 
can set the following parameters:

· Input Filename : Enter the filename of the archive that you would like to convert. If you have a 
currently opened archive, its filename is automatically inserted here for you.

· Output Filename : Enter the filename of the converted archive. 
· Output Format : Select the format of the converted archive. PicoZip supports conversion to 8 

different formats: .bh, .cab, .lha, .lzh, .zip, .tar, .tar.gz, .jar.
· Perform Integrity Check : Check this if you want PicoZip to perform an integrity check after doing 

the conversion.
· Delete Original File After Convert : Check this if you want PicoZip to delete the original archive file 

after performing the conversion.

Click on the Convert button after setting the above parameters. A dialog box will inform you when the 
archive has been successfully converted.

You can also convert an archive from within Windows Explorer by right clicking on the archive you want 
to convert, then choose Convert Archive Format from the popup context menu. The same Convert 
Archive dialog box mentioned above will be displayed.

If you want to convert many archives, use the batch convert feature to save time.



Make Self-Extracting Archive

To convert an archive into a self-extracting archive, open the archive you want to convert, then choose 
Make .EXE File from the Actions menu. The  Save EXE As … dialog box will appear. Select the folder 
where you want the self-extracting archive to be saved in, and also enter a filename for it. Click the Save
button to complete this operation. 

This feature is currently supported for the following archive file formats: ace, arj, bh, jar, lha, lzh, rar, 
zip.

Windows Explorer

You can also access this feature from within Windows Explorer. In Windows Explorer, right click on the 
archive file you wish to make into an exe, then select Make .EXE from the popup context menu. After 
that, follow the steps given above.

Tip ! A self-extracting executable can also be created by selecting the required files and/or folders in 
Windows Explorer, then right click them. In the popup context menu, select Add to "Filename.EXE". 
PicoZip will automatically compress the files and/or folders you selected, then convert it to a self-
extracting archive all in one step.

What is a self-extracting archive ?

A self-extracting archive is an archive file that can extract itself without the use of any other archive utility.
It has an extension of .EXE, and can be executed like any other program. This is useful for distributing 
archive files to others who may not have an archive utility (like PicoZip), or may not know how to use 
one.

Self-extracting archives created using PicoZip adds a mere 30kb (may vary slightly in size depending on 
archive type) to the size of the archive. This is a small price to pay to get the convenience of a self-
extracting archive.

Related Topic:
Introduction to Archives



Check Out Archive

The purpose of this feature is to make it very easy for you to check out (view, examine or run) files in an 
archive. It automatically creates a temporary folder, extracts all files from the archive into the folder, and 
opens an explorer window with shortcuts to all the files in the temporary folder. You can then double click
any shortcut in the window to perform action normally associated with the file. PicoZip can also help you 
delete the temporary folder, including all extracted files when you close the archive or exit PicoZip.

How to use Check Out ?

To check out an archive, first open the archive in PicoZip. Then, click on the Check Out toolbar button or
choose Check Out from the Actions menu. The Check Out dialog box is displayed. You can set the 
following parameters:

· Folder : The temporary folder where files extracted from the current archive will be placed.
· Group Name : This is the program group name (Check Out window name) that will be created 

under the “Start Menu > Programs”, which will contain the shortcuts to the extracted files.
· Maximum Icons : Specify the maximum number of shortcuts to create in the program group (Check 

Out window).
· Create icons for programs and documents only : If this option is checked, shortcuts will only be 

created for executable files and files with associations.
· Scan extracted files with Virus Scanner : If this option is checked, PicoZip will scan the extracted 

files for virus after extracting them. This option is disabled if no Antivirus Utility was configured.

Once you have set the above parameters to your needs, click the  OK button. PicoZip will extract the 
files, then show the Check Out window. 

When you exit PicoZip or close the archive file, PicoZip will ask you whether to delete the temporary 
folder. If you click Yes, PicoZip will automatically delete the temporary folder and the program group that 
was created earlier.



Install Software in Archive

The Install feature in PicoZip makes it extremely easy to install software that are distributed in archives. 
This feature is enabled only if an archive contains a file named Setup.exe or  Install.exe that has no 
stored path.    This Install feature automatically extracts all files to a temporary folder, then runs the setup 
program. Once the setup has completed, PicoZip automatically deletes the temporary folder, including all
extracted files.

How to Use Install

First, you need to open an archive in PicoZip. Then choose Install from the Actions menu. A popup 
dialog box will ask you to confirm that you want to proceed. Click the Yes button. PicoZip then extracts 
all files to a temporary folder and runs the setup program. After you have completed installing the 
software, go back to PicoZip and click the OK button on the popup dialog box.    Note: Do NOT click the 
OK button in the last step before installation is completed. This is important because PicoZip 
automatically deletes the temporary folder, including the extracted files once you click the OK button.

If the Install menu item is not enabled, but you recognize an installable file, you can use the Check Out 
feature instead, and run the installable file from the Check Out window. 



UUencode Archive

This feature allows you UUencode an archive. This is useful when you need to send a file across mail 
systems that do not support binary email attachments (mainly older systems). To perform this operation, 
choose UUencode  from the Tools menu. The UUencode dialog box appears. You can set the following
parameters:

· Input Filename : Enter the filename of the archive that you would like to convert. If you have a 
currently opened archive, its filename is automatically inserted here for you.

· Encoded Filename : Enter the filename of the UUencoded file.
· Encoding Method : Select the encoding method.
· Spanning Size : Select the spanning size. Setting a spanning size means if your file is larger than 

the size you specified, PicoZip will split the UUencoded file into several files, with each file's 
maximum size equal to the spanning size. Example: If you have an archive of size 380kb, and you 
set spanning size to 100kb, after UUencoding, you get 3 files of size 100kb and 1 file of size 80kb.

Click on the OK button after setting the above parameters. A dialog box will inform you when the archive 
has been successfully UUencoded.



Viewing or Editing Archive Comment

A comment is an optional text information stored in Zip files, normally used to describe the contents of 
the Zip archive. This feature is available for Zip files only.

You can view comments embedded in an archive by choosing Comment from the View menu or clicking
the Comment button (  ) near the bottom left of the PicoZip main window. The Comment dialog box 
allows you to view, edit or delete a comment. 

The Save button is enabled only if you make any changes to the comment. The Clear button erases the 
entire comment. If you click the  Save button after clicking Clear, PicoZip will delete the comment in the 
Zip archive.



Viewing Archive Properties

You can view properties of the currently open archive by choosing Properties from the File menu or 
clicking the Properties button (  ) near the bottom left of the PicoZip main window.

The Properties dialog box provides you with the following information:

· Filename
· Archive type
· Date
· Total files in archive
· Packed size
· Unpacked size
· Compression ratio
· File attributes
· Comment

Related Topic:
Viewing or Editing Archive Comment



Copy, Move, Rename or Delete an Archive

The Copy Archive, Move Archive, Rename Archive and Delete Archive menu items in the  File menu
allows you to perform file management operations from within PicoZip.

· Copy Archive : Copies the currently open archive to a different location. You will be prompted for 
the filename and folder where you want to copy the archive to.

· Move Archive : Moves the currently open archive to a different location. You will be prompted for the
filename and folder where you want to move the archive to.

· Rename Archive : Renames the currently open archive. You will be prompted for a new filename. 
Please note that you cannot change the file extension. If you want to changed the archive file format,
use Convert Archive Format instead.

· Delete Archive : Deletes the currently open archive. You will be prompted for confirmation before 
deleting the archive.



Password Protect Archive Contents

The contents of an archive file can be encrypted to protect it. In the main PicoZip window, password 
protected files are shown with a small lock icon (  ) in front of the file name.

Password Protecting Files In A New Archive
If you are creating a new archive, and want to password protect the files added, do the following steps:

1. Create a new archive.
2. In the Add dialog box, click on the Password button and enter a password in the Password 

dialog box. If    Mask Password is checked, you need to enter the password again under Verify 
Password. After that, select the required encryption method and click the OK button.

3. Proceed to select the files to add to your archive, then click the Add button.
4. Done. All files you added in Step 3 are password protected.

Password Protecting Files In An Existing Archive
To password protect files in an existing archive, do the following:

1. Open the archive in PicoZip.
2. Choose Password Protect from the Actions menu and enter a password in the Password 

dialog box.    If    Mask Password is checked, you need to enter the password again under 
Verify Password. After that, select the required encryption method and click the OK button.

3. All the files in your archive will be password protected using the password and encryption 
method that you just selected.

Removing the Password
You can remove the password by opening the Password dialog box and deleting the password, then 
click OK. Password protection will be removed from all the files in your archive. 

Masking Password
You can use the Mask Password option in the Password dialog box to hide your password while it is 
being typed. This prevents other people around you who might be looking from seeing your password. 
Please note that if you check this option, you need to enter your password twice to prevent any typing 
mistakes.

Encryption Methods
There are several encryption methods that you can choose from:

· Zip 2.0 Encryption : This method of encryption is only meant to protect your archives from casual 
users as it is fairly weak. However, it is the most common encryption method for Zip files and is 
widely supported by most archive utilities. 

· 128-bit/256-bit AES Encryption : This method of encryption uses the strong AES encryption 
algorithm. The National Institute of Standards and Technology (NIST) selected AES as the standard 
for both U.S. government and private data encryption.You should use this method of encryption if 
you need greater security. However, this encryption method is still fairly new for Zip files, and is only 
support by a few archive utilities at this time.



Using Favorites

The Favorites menu allows you to quickly browse your frequently used folders for archives. To go to any 
favorite folder, just select it from the Favorites menu. PicoZip will open the built-in explorer and display 
the archive files in the favorite folder you selected. You can then open any archive by double clicking it.

Organize Favorites

To manage you list of favorite folders, choose Organize Favorites from the Favorites menu. The 
Organize Favorites dialog box will be displayed.

Move any favorite item in the List of Favorites by selecting it, then click the Up or Down button. You 
can also move items by dragging it with your mouse. To remove a favorite item, select it, then click the 
Remove button. After making any changes, click the OK button to save those changes. If you click the 
Cancel button, any changes you made will be lost.



Repair Damaged Zip Archive

This feature allows you to attempt to repair any Zip archives (other archive formats are not supported) 
that are damaged or corrupted. Choose Repair Damaged Zip Archive from the Tools menu, then follow
the steps below:

1. You will be asked to select the Zip file you want to repair.    Locate your Zip archive, then click the
Open button.

2. You will be asked where to save the repaired file, and what filename to use. By default, PicoZip 
will use the same filename as the damaged Zip file with the word “_fixed” added at the end of the
filename (e.g. Damaged.zip becomes Damaged_fixed.zip). Click the Save button.

3. The View last Output dialog box will be displayed, showing you the number of files that were 
recovered from the damaged Zip archive. Click the Close button to return to PicoZip.

You can also access this feature from within Windows Explorer. In Windows Explorer, right click on the 
Zip file you wish to repair, then select Repair Zip Archive from the popup context menu. After that, 
follow steps 2-3 above.

Related Topic:
Test Archive



Test Archive

You can use this feature to test the integrity of the currently open archive. To perform the test, choose 
Test Archive from the Actions menu. PicoZip will carry out the test, and if it finds any problems with 
your archive, it will display the View Last Output dialog box, showing you the test results. 

You can also access this feature from within Windows Explorer. In Windows Explorer, right click on an 
archive file you wish to test, then select Test Archive from the popup context menu. If any problems 
were found in your archive, it will display the View Last Output dialog box, showing you the test results.

Related Topic:
Repair Damaged Zip Archive



Configuring PicoZip Toolbar

The toolbar in the main window of PicoZip can be configured to your liking. You can add buttons for 
direct access to features that you frequently use, or remove buttons of less used features. To do this, 
right click anywhere on the toolbar and a popup context menu will be displayed with the following 
options:

· Show Text : If checked, text captions will be shown for all buttons.

· Show Tooltips : If checked, tooltip help will be displayed if you move your mouse cursor over a 
button

· Use Flat Buttons : If checked, the buttons will use a similar style to buttons on Internet Explorer 
which does not have a fixed 3D border around it.

· Configure Toolbar :    Display the toolbar configuration dialog box. Click here to learn more about 
the toolbar configuration dialog box.

Related topic:
Configuration



Using PicoZip Explorer

PicoZip Explorer is located on the left side of PicoZip's main window. To view the explorer, choose 
Explorer from the  View menu. PicoZip Explorer contains the two tabs described below:

My Computer Tab
Allows you to quickly browse and open archive files on your computer.    The top half allows you to 
browse folders, while the bottom half shows the archive files in the currently selected folder. When you 
find a folder that you access often, you can add it to Favorites by choosing Add To Favorites … from 
the  Favorites menu.

Archive Tab
Shows you the tree-view for the folder structure within an archive that is currently opened. You can 
browse the contents in a particular folder by selecting it. To see all files regardless of which folder they 
are in, select Show All Files. The two buttons above the tree-view allows you to expand or collapse the 
entire tree-view.

You can close the explorer by repeating the same steps you used to open it. The explorer can also be 
resized by dragging the vertical bar between explorer and the archive contents list.

Click here to learn more about Favorites.



Using the Filter

This feature allows you to filter the list of files in the currently open archive that is shown in the main 
PicoZip window. This is useful when an archive contains a lot of files, and you are only interested in 
certain files.

To show the Filter toolbar, choose Show Filter from the View menu. The filter toolbar will appear above 
the files listing. You can make use of the  * or ? wildcard in your filter. 

The * wildcard character represents zero, one or more characters, while the ? wildcard character 
represents exactly one character.

Here are some examples of ways to use the filter:

· *.doc : Only show files with the extension .doc
· read*.* : Shows any files that starts with “read”, such as readme.txt, ReadFirst.doc, read.1st, 

Read.exe
· db????.xls : Shows only files with exactly 4 characters between “db” and “.xls”, such as db1999.xls,

dbfast.xls, db_123.xls
· setup.exe : Shows only files with the name “setup.exe”.

Filters that you recently used are automatically saved, and you can click on the down-arrow button in the
filter edit box to see a list of them. You can click on any filter listed to immediately apply it. 

To clear the filter, click on the Remove Filter button. To hide the Filter toolbar, repeat the same steps you
took to show it.



Configuration Introduction

PicoZip is highly customizable. To open the Configuration dialog box, choose Configuration from the 
Options menu. The dialog box contains several tabs that groups settings according to their purpose as 
described below:

· View : Settings related to the appearance of the main PicoZip window. Click here to learn more.

· Toolbar : Settings related to the PicoZip toolbar. Click here to learn more.

· Skin : Settings related to the toolbar skin. Click here to learn more.

· Folders : Settings related to Open, Add, Extract and Check Out folders. Click here to learn more.

· Program Locations : Settings for virus scanner. Click here to learn more.

· Shell Extensions : Settings related to Windows shell integration. Click here to learn more.

· File Associations : Settings related to associating archives with PicoZip. Click here to learn more.

· Tray Tool : Settings related to PicoZip Tray Tool. Click here to learn more.

· Security : Settings related to security related issues. Click here to learn more.

· Miscellaneous : Miscellaneous settings not covered in other tabs. Click here to learn more.



View Tab

You can configure the settings below by clicking on the View tab in the Configuration dialog box.

Columns to Show

Select the columns that you want to see in the file listing on the main PicoZip window. Clicking the 
Default button will revert the column settings back to the PicoZip default.

General

· Enable full row select : The default method of selecting a file in PicoZip is to click on the filename 
(similar to Windows Explorer). If you check this option, you can select a file by clicking anywhere 
along the same row as the file.

· Show grid lines : Check this option to display grid lines in the file listing to separate rows and 
columns in the main PicoZip window.

· Always reset sorting to first column : If you check this option, the file list in the main window will 
always be sorted on the first column when you open or create a new archive file.

· Set Font : You can select the font type, size, color, etc. that you would like PicoZip to use when 
displaying the list of files in the main window.

Explorer Panel

These settings will allow you to configure the behaviour of the Explorer Panel that is shown on the left of 
the files list. 

· Default Explorer Panel tab when starting PicoZip : You can select which tab you want PicoZip to 
show by default everytime you start PicoZip:

· Last Selected Tab : Show the tab that was selected the last time you run PicoZip.
· My Computer : Show the My Computer tab where you can browse for archive files.
· Archive : Show the Archive tab where you can browse the folders within an archive file.

· Always switch to archive tab on file open : If you check this option, PicoZip will automatically 
switch to the Archive tab everytime you open an archive file.

Other Configuration Topics: 
Toolbar Tab, Skin Tab, Folders Tab, Shell Extensions Tab, File Associations Tab,    Program Locations 
Tab, Tray Tool Tab, Security Tab, Miscellaneous Tab



Toolbar Tab

You can configure the settings below by clicking on the Toolbar tab in the Configuration dialog box.

Check Buttons to Show On Toolbar

You can select which buttons to show on the toolbar by checking them in the list on the left. You can also
change the position of these buttons by selecting it, then click the Move Up or Move Down button to 
change the position. Alternatively, you can also use drag-and-drop to reposition the buttons.

Toolbar Options

· Use Big Buttons : If checked, a larger button is shown on the toolbar.

· Show Text : If checked, a short text descriptions will be shown for all buttons.

· Show Tooltips : If checked, tooltip help will be displayed when you move your mouse cursor over a 
button.

· Use Flat Buttons : If checked, the buttons will use a similar style to buttons on Internet Explorer 
which does not have a fixed 3D border around it.

Show filter by default : If you use the filter feature often, you can check this option to make PicoZip 
display the Filter toolbar by default every time PicoZip is started.

Note: You can also make changes to the toolbar without going through the Configuration dialog box. 
Click here to see how.

Other Configuration Topics: 
View Tab, Folders Tab, Skin Tab, Shell Extensions Tab, File Associations Tab,    Program Locations Tab, 
Tray Tool Tab, Security Tab, Miscellaneous Tab



Folders Tab

You can configure the settings below by clicking on the Folders tab in the Configuration dialog box.

Open Folder

These options determine which folder is automatically displayed in the Open Archive dialog box by 
default. Available options are:

· System default : PicoZip changes to the default system folder.
· Last open folder : PicoZip changes to the folder containing the most recently opened    archive file.
· Folder : PicoZip always changes to the folder you specify here. 

Add Folder

These options determine which folder is automatically displayed in the Add dialog box by default. 
Available options are:

· Same folder as the archive file : PicoZip changes to the same folder as the currently open archive.
· Last add folder : PicoZip changes to the folder you used in the last Add operation.
· Folder : PicoZip always changes to the folder you specify here. 

Extract Folder

These options determine which folder is automatically displayed in the Extract dialog box by default. 
Available options are:

· Same folder as the archive file : PicoZip changes to the same folder as the currently open archive.
· Last extract folder  : PicoZip changes to the folder you used in the last Extract operation.
· Folder : PicoZip always changes to the folder you specify here. 

Checkout Base Folder

This option allows you to specify the default base folder to use for Check Out. If no folder is specified 
here, PicoZip will use the same folder as the open archive for Check Out.  

Temporary Folder

This option allows you to specify the temporary folder that PicoZip will use when compressing files. If no 
folder is specified here, PicoZip will use the default temporary folder provided by Windows.

Other Configuration Topics: 
View Tab, Toolbar Tab, Skin Tab, Shell Extensions Tab, File Associations Tab,    Program Locations Tab, 
Tray Tool Tab, Security Tab, Miscellaneous Tab





File Associations Tab

You can configure the settings below by clicking on the File Associations tab in the Configuration dialog
box.

Enable file associations : If this option is checked, PicoZip will associate itself with archive files types 
that it supports 
(.ace, .arc, .arj, .bh, .cab, .gz, .jar, .lha, .lzh, .mim, .rar, .tar, .tgz, .uue, .uu, .war, .xxe, .z, .zip, .zoo). This 
allow Windows to automatically run PicoZip when you double click an archive file in Windows Explorer 
or My Computer. Unchecking this option will cause PicoZip to remove all its associations. 

Check file associations every time PicoZip starts : If this option is checked, every time you start 
PicoZip, it will check whether the file associations have been modified by other software. If there were 
any modifications, PicoZip will offer to automatically re-associate itself to archive files. 

Archive Types : Here, you can select which archive formats you want associated with PicoZip.

Note: It is recommended that you leave all the above options checked. Also, on Windows NT/2000/XP, 
only users with Admin level access can change these settings.

Other Configuration Topics: 
View Tab, Toolbar Tab, Skin Tab, Folders Tab, Shell Extensions Tab, Program Locations Tab, Tray Tool 
Tab, Security Tab, Miscellaneous Tab



Program Locations Tab

You can configure the settings below by clicking on the Program Locations tab in the Configuration 
dialog box.

File Viewer

The settings in this section allows you to configure which program to use to view the files in an archive. 
You can choose from the following options:

· Use associated program : Always open the file you select using its associated program.

· Use external viewer : Always open the file you selected using the external viewer that you specified
in the    "Location of your external viewer" setting.

· Use external viewer if no associated program : Open the file you selected using the external 
viewer only if there is associated program for the file.

· Ask me : When you try to view a file, PicoZip will popup a dialog box to ask you whether to use its 
associated program or the external viewer.

Location of your external viewer : Full path to the program you would like to use as an external 
viewer. This setting must contain a valid program if you selected any setting above other than "Use 
associated program".

Virus Scanner

Product : If you have no antivirus software installed, select None and skip the rest of the options on this 
tab. Otherwise, select your antivirus software from the list. If your antivirus software is not in the list, 
select Custom. 

Location of your antivirus software : If you selected a setting other than None or Custom  in the 
previous setting, the filename for your selected antivirus software would be automatically filled in. 
However, you still need to click on the browse button to locate the directory where this file is located.  

Parameters : If you selected a setting other than None or Custom in the  Product setting, the default 
parameters automatically filled in by PicoZip should work just fine. If you selected Custom in the product
setting, you should enter the necessary parameters to run the virus scanner you entered in the previous 
setting.

The special character that you can use in this field is *.*. PicoZip automatically replaces *.* with the 
actual path to the files that needs to be scanned so that your virus scanner can find them.. For example, 
if the parameter you entered is :

/s *.*

PicoZip will change it to:

/s C:\Temp\Test\*.*

Assuming "C:\Temp\Test" is the temporary directory where PicoZip placed the extracted files.



If no parameter is entered, PicoZip will append a list of all filenames that needs to be scanned as the 
parameter.

Other Configuration Topics: 
View Tab, Toolbar Tab, Skin Tab, Folders Tab, Shell Extensions Tab, File Associations Tab, Tray Tool Tab,
Security Tab, Miscellaneous Tab



Miscellaneous Tab

You can configure the settings below by clicking on the Miscellaneous tab in the Configuration dialog 
box.

· Show comments when opening archive files : If checked, PicoZip will automatically display the 
comments of an archive when you open an archive that contains a comment.

· Always have PicoZip window stay on top : If checked, the main PicoZip window will always stay 
on top of other normal windows on your desktop.

· Show confirmation after compress : If checked, PicoZip will display a confirmation dialog box after
performing a compression (add/create).

· Show confirmation after decompress : If checked, PicoZip will display a confirmation dialog box 
after performing a decompression (extraction).

· Automatically show the open dialog box at startup : If checked, the Open dialog box will 
automatically be displayed every time you start PicoZip.*

· Automatically show the Wizard interface on startup : If checked, the Wizard will automatically be 
displayed every time you start PicoZip.*

* Note: These two options are mutually exclusive. You cannot check both options at the same time. 

Shortcuts

You can select whether you want PicoZip to create its shortcut on the Windows Desktop and/or Windows
Start Menu. If you uncheck any of these options, PicoZip will delete the corresponding shortcut.

Most Recently Used Files

The Recently Used Files list is located under the File menu, and contains shortcuts to the most recently 
opened archives. Clicking any shortcut    listed in the Recently Used Files list will open it.

· Number of files to show in Recent Files list : You can set the maximum number of shortcuts to 
show in the list.

· Clear obsolete items in Recent Files list on startup : If checked, PicoZip will automatically 
remove any shortcut in the list that no longer exist or is not accessible.

Other Configuration Topics: 
View Tab, Toolbar Tab, Skin Tab, Folders Tab, Shell Extensions Tab, File Associations Tab, Tray Tool Tab,
Security Tab, Program Locations Tab



Frequently Asked Questions

This page contains answers to Frequently Asked Questions (FAQ). For a more comprehensive and up-to-
date FAQ, please visit our website. If you are new to archive utilties, do take a look at our online illustrated
manual at http://www.picozip.com/visualmanual/vguide.html. It gives you step-by-step instructions for 
common tasks, accompanied by illustrative screenshots to make learning PicoZip quick and simple.

New Users

1. What is an archive ?
2. I just installed PicoZip. How do I get started ?

Specific Questions

1. How do I open an existing archive ?
2. How do I create a new archive ?
3. How do I extract files from an archive ?
4. How do I add files to an archive ?
5. How do I view files in an archive without extracting them ?
6. How do I delete files in an archive ?
7. How do I make a self-extracting archive ?
8. How do I use the Backup feature ?
9. How do I schedule backups to run automatically ?
10. How do I use PicoZip to email archives ?
11. How do I use PicoZips features that are integrated to Windows Explorer ?
12. How do I split large ZIP files into several smaller files ?
13. How do I password protect the contents of a ZIP file ?
14. How do I repair a damaged ZIP file ?

Registration/Support

1. How do I register PicoZip and what does it cost ?
2. How do I enter the registration code after buying PicoZip ?
3. How do I contact PicoZip support ?



Hints and Tips

Beginners

If you are new to archive files, you should read the introduction to archives first. After that, go through the 
Quick Start section while trying out what you read on PicoZip. The best way to learn how to use PicoZip is
to try out PicoZip as you read the "Quick Start" guide. Wherever you are in PicoZip, if you face any 
difficulty, just press the F1 key on your keyboard to get help. Also, you may want to take a look at the FAQ
to get answers to frequently asked questions. 

Power Users

Most features in PicoZip were designed to be easy to use, so power users should have little difficulty in 
using PicoZip. There are many features that may be of interest to you, such as: backup, batch operations 
and windows shell integration. PicoZip is also designed to be highly customizable, so take a look at the 
configuration section for information on how to configure PicoZip.



Contact

Technical support is provided to all registered users at no extra cost. All users can get support from our 
web site at http://www.picozip.com. Please check at our web site before emailing us with your problem, 
as it may have already been resolved. 

You can report any problems to us by emailing support@picozip.com or better still, submit it through our 
online support form at http://www.picozip.com/support.html. When emailing us with a problem, please 
include the following information:

1. When and how did the problem occur ?
2. Can you reproduce the problem ? If yes, please list down the steps.
3. Which version of PicoZip are you running ? You can get this information by choosing About from

the  Help menu.
4. Which version of Microsoft Windows are you using (95, 98, 98 Second Edition, ME, NT4, XP, 

2000, etc.) ?
5. If there were any error messages shown, please include the full text of the error messages.
6. Any other information which you think may help us identify the cause of this problem.

We welcome bug reports from anyone, regardless of whether you are a registered user or not.

Related Topics:
Ordering Information



Acubix PicoZip License

PicoZip Copyright © 2001-2004 Acubix. All Rights Reserved.

There are two license agreements in this page. If you have an evaluation version of PicoZip, please read
the section titled PicoZip Evaluation License. If you have registered your copy of PicoZip by paying the
licensing fees, please read the section titled PicoZip Standard License.

PicoZip Evaluation License

By using, copying, transmitting, distributing or installing PicoZip, you agree to all the terms of this 
License.    If you do not agree to any of the terms of this License, do not use, copy, transmit, distribute, or
install PicoZip.

PicoZip is not free software.    Subject to the terms below, you are hereby licensed by Acubix to use 
this software for testing purposes without charge for a period of 30 days, starting from the day you install
PicoZip. Unregistered use of PicoZip after the 30 day evaluation period is a violation of U.S. and 
international copyright laws. Ordering information is available here, or you can order online at 
http://www.picozip.com.

You may distribute copies of this evaluation version of PicoZip to anyone, provided it is not modified in 
any way. You are free to include copies of this evaluation version of PicoZip on CD-ROM or any other 
media providing that you do NOT charge the end-users for the software, and that you inform us at 
sales@picozip.com    describing when and how you wish to distribute the software. You may not 
repackage or make alterations to any file in the original PicoZip distribution. You are strictly prohibited 
from charging or requesting any form of payment, for any copies, however made, without prior 
written permission from Acubix. Acubix reserves the right to revoke the above distribution rights 
at any time. 

Self-extracting archives created using this evaluation version of PicoZip contains copyrighted software, 
proprietary notices and other identifying information, which may NOT be modified or altered in any way. 
You are NOT licensed to distribute self-extracting archives created by this evaluation version of 
PicoZip. 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, reverse 
engineer, or transfer the licensed program, or any subset of the licensed program, except as provided for
in this agreement.    Any such unauthorized use may result in criminal and/or civil prosecution.

This software, and all accompanying files, data and materials, are distributed "AS IS" and without
warranties of any kind, whether expressed or implied.    In no event shall Acubix, or its principals,
shareholders, officers, employees, affiliates, contractors, subsidiaries, or parent organizations, 
be liable for any incidental, consequential, or punitive damages whatsoever relating to the use of 
PicoZip, or your relationship with Acubix.

In addition, in no event does Acubix authorize you to use PicoZip in applications or systems 
where PicoZip's failure to perform can reasonably be expected to result in a significant physical 
injury, or in loss of life.    Any such use by you is entirely at your own risk, and you agree to hold 
Acubix harmless from any claims or losses relating to such unauthorized use.

This Agreement is the complete statement of the Agreement between the parties on the subject matter, 
and merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. 



All rights of any kind in PicoZip which are not expressly granted in this License are entirely and 
exclusively reserved to and by Acubix.    You may not rent, lease, modify, translate, reverse engineer, 
decompile, disassemble or create derivative works based on PicoZip. You may not make access to 
PicoZip available to others in connection with a service bureau, application service provider, or similar 
business, or use PicoZip in a business to provide file compression, decompression, or conversion 
services to others.

[ End of PicoZip Evaluation License. ]

PicoZip Standard License

By using, copying, transmitting, distributing or installing PicoZip, you agree to all of the terms of this 
License.    If you do not agree to any of the terms of this License, do not use, copy, transmit, distribute, or
install this copy of PicoZip.

This registered copy of PicoZip may be installed on computers used by one single person only, or it may 
be installed on one computer used non-simultaneously by several persons, but NOT both. This is NOT a
concurrent use license. You may not install this copy of PicoZip for access through any network, 
without first obtaining a license for each computer that will access PicoZip over that network, regardless 
of whether they are accessing PicoZip concurrently or otherwise.

You are strictly prohibited from distributing registered copies of PicoZip.  To do so would be a 
violation of U.S. and international copyright laws.

Self-extracting archives created using this evaluation version of PicoZip contains copyrighted software, 
proprietary notices and other identifying information, which may NOT be modified or altered in any way. 
You may use PicoZip to create and/or distribute an unlimited number of self-extracting archive files. 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, reverse 
engineer, or transfer the licensed program, or any subset of the licensed program, except as provided for
in this agreement.    Any such unauthorized use may result in criminal and/or civil prosecution.

This software, and all accompanying files, data and materials, are distributed "AS IS" and without
warranties of any kind, whether expressed or implied.    The user must assume the entire risk of 
using this program. Any liability of Acubix will be limited exclusively to refund of the purchase 
price paid. In no event shall Acubix, or its principals, shareholders, officers, employees, affiliates,
contractors, subsidiaries, or parent organizations, be liable for any incidental, consequential, or 
punitive damages whatsoever relating to the use of PicoZip, or your relationship with Acubix.

In addition, in no event does Acubix authorize you to use PicoZip in applications or systems 
where PicoZip's failure to perform can reasonably be expected to result in a significant physical 
injury, or in loss of life.    Any such use by you is entirely at your own risk, and you agree to hold 
Acubix harmless from any claims or losses relating to such unauthorized use.

This Agreement is the complete statement of the Agreement between the parties on the subject matter, 
and merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. 

All rights of any kind in PicoZip which are not expressly granted in this License are entirely and 
exclusively reserved to and by Acubix.    You may not rent, lease, modify, translate, reverse engineer, 



decompile, disassemble or create derivative works based on PicoZip. You may not make access to 
PicoZip available to others in connection with a service bureau, application service provider, or similar 
business, or use PicoZip in a business to provide file compression, decompression, or conversion 
services to others.

[ End of PicoZip Standard License. ]



Ordering Information

You can order PicoZip online using credit card, check or by telephone. Your purchase is backed by our 
100% risk-free 30-day money back guarantee. For more information, please see 
http://www.picozip.com/order.html. 

Registration Benefits:
· Your own personalized registration key
· Unlimited usage with no popup or any other registration reminders
· Priority email support from the developer of PicoZip
· FREE upgrade to all future versions of PicoZip
· Automatic notification of upgrades

One registered copy of PicoZip may be installed on computers used by one single person only, or it may 
be installed on one computer used non-simultaneously by several persons, but NOT both. Please see 
the license agreement for more detail.

PicoZip Pricing

Single License US$ 24.95
2 License Pack US$ 42.00
5 License Pack US$ 90.00
10 License Pack US$ 130.00
25 License Pack US$ 240.00
50 License Pack US$ 365.00
100 License Pack US$ 520.00
200 License Pack US$ 900.00
500 License Pack US$ 1500.00
1000 License Pack US$ 2500.00

For higher licensing volumes, please contact our sales staff at : sales@picozip.com. We offer special 
discounts on site licensing for large corporations. Non-profit organisations and educational institutions 
are also entitled to special discounts.

The prices shown above are subject to change. Please check our    website for the latest pricing.

You can also take a look at our competitive comparison of PicoZip and WinZip by clicking here.

Related topics:
Enter Registration Code
Awards and Testimonials
Reviews
Contact



Extract Dialog Box

The following options are displayed in the Extract dialog box :

Extract To : You can type in the full path to the folder that you would like to place the extracted files. If 
the folder you specified does not exist, PicoZip will automatically create it for you.

Select Destination Folder : Instead of typing in the full path in the Extract To field above, you can use 
this to select the target folder. When you click on any folder here, the full path to that folder will be 
automatically shown in the Extract To field. 

Files to Extract : 
· Selected Files  : Only extract the files that you selected in the main PicoZip window.
· All Files : Extract all files in the archive.

Restore original folders : If you check this option, PicoZip will restore the original path of the files 
stored in the archive, using the Extract To folder as the base folder. This is the recommended setting. If 
you do not check this option, PicoZip will extract all files in the archive to the Extract To folder, 
regardless of any folder names stored in the archive.

Confirm file overwrites : Check this option if you want to be prompt before an existing file is overwritten
by a file being extracted from the archive.

Create stored directories : Check this option to restore folders even if it is empty.

Restore file attributes : Restore attributes of files stored in the archive after extracting it.

Restore file dates : Restore the original dates of the files stored in the archive after extracting it. If this 
option is not selected, all extracted files will use the current date as its creation date.

Open in Windows Explorer after extracting : Check this option if you want PicoZip to automatically 
run Windows Explorer and open the folder where you extracted the files.

Note: The default Extract To folder is configurable. Click here to learn more.

Related Topics:
Extracting Files,    Overwrite Dialog Box



Add Dialog Box

The following options are displayed in the Add dialog box :

Action - This drop-down list provides 3 choices: 
· Add files : Add all specified files to the archive.
· Freshen existing files : Updates files already in the archive that match the specified files.
· Move files : Same as “Add Files”, but deletes the files after it has been added to the archive.

Compression :  This drop-down list provides 4 choices : Maximum, Normal, Minimum, None. 
Maximum gives best compression, but takes the longest time to complete. The lesser the compression, 
the faster PicoZip can create the archive. Choosing None means PicoZip will not compress the files 
before adding it to the archive.

Multiple Disk Spanning :  This drop-down list provides 2 choices: Automatic, No Spanning. Selecting 
Automatic means you will be prompted to insert a new disk if the archive file being created cannot fit in 
the current disk. If you select No Spanning, a “disk full” message will be shown if the archive file 
exceeds the space available on the current disk. This is mainly applicable to removable media.

Password : Click this button to password protect the files that you are about to add to the archive. Click 
here to learn more about this feature.

Add With Wildcards : If you want to add many files that matches certain wildcards (e.g. *.doc will add 
all files of type “doc”), enter the required string with wildcards in the File name field and click this button. 
Other examples of wildcards usage:

Wildcard Matching Filenames

Test?.txt Test1.txt, Test2.txt, TestZ.txt 
Test?.* Test1.txt, Test1.doc, Test3.xls
Test*.* Test1.txt, Test100.doc, TestFile.ppt 

You can use more than one wildcard in the File name field. For example, if you enter “*.doc *.xls *.ppt”, 
PicoZip will add all files with the .doc, .xls and .ppt extensions.

Folders :
· Save full path info : If you select this option, PicoZip will store the full path from the root folder with 

all files added. 
· Include subfolders : Checking this option means PicoZip will search all subfolders under the 

currently selected folder when looking for files to add. For example, if you check this option, enter *.* 
in File name , and click Add With Wildcards, all files in this folder and all its subfolders will be 
added to the archive.



Using the Wizard 

The PicoZip Wizard makes it extremely easy for you to create a new archive, add files to an existing 
archive or extracting files from an archive. To activate the Wizard, click on the Wizard toolbar button or 
choose Wizard from the File menu. While in the wizard, you can click on the Help button or press the F1
key at any time to get help on the specific screen.



Wizard - What do you want to do ?

You have 3 options to choose from:

· Create a new archive file : Choose this option if you want to create a new archive file.
· Add files to an existing archive file : Choose this option if you want to add more files to an existing

archive file.
· Extract all files from an existing archive : Choose this option if you want to extract files from an 

existing archive file. 

Note: You can click the Close button at any time to abandon what you were doing and exit the wizard.



Wizard - Choose an archive file name

Choose a file name for your new archive. Type a filename in the File name field, or click Browse to 
explore your computer. When you click Browse, the Browse dialog box is shown. You can locate the 
folder where you want to place your new archive, then type a filename in the  File name field and click 
the Open button to close the Browse dialog box. The folder and filename you specified in the Browse 
dialog box is automatically shown in the File name field.

Click the Next button to proceed. Please note that if you specified a filename that already exists, PicoZip
will ask you if you want to overwrite it.



Wizard - Select files to add to your archive

You can now select files and/or folders that you want to add to your new archive file. Please note that 
adding a folder will automatically add all files and subfolders in that specified folder.

Click on Add Files to select files to add. If you want to add whole folders, click on the Add Folders 
button. 

If you want to remove any file or folders, select them from the list and click the Remove button.

Click the Finish button to proceed.



Wizard - Select existing archive file

Select the existing archive file to which you would like to add more files by clicking on the Browse 
button. When you click Browse, the Browse dialog box is shown. You can browse your computer and 
locate the archive file, then click the Open button to close the Browse dialog box. The folder and 
filename you specified in the Browse dialog box is automatically shown in the File name field.

Click the Next button to proceed.



Wizard - Select archive file to extract

Select the existing archive file from which you would like to extract files by clicking on the Browse 
button. When you click Browse, the Browse dialog box is shown. You can browse your computer and 
locate the archive file, then click the Open button to close the Browse dialog box. The folder and 
filename you specified in the Browse dialog box is automatically shown in the File name field.

Click the Next button to proceed.



Wizard - Select target folder

Choose a folder to place the files extracted from the archive file you selected earlier. Type the full path to
a folder in the Folder field, or click the Browse Folder button to open the Select Folder dialog box. In 
the Select Folder dialog box, find the folder where you want to place the files, then click the OK button.

Other options:

· Display extracted file icons after extracting : If this option is checked, PicoZip will automatically 
open an Explorer window showing the extracted files.

· Overwrite matching files automatically : If this option is checked, PicoZip will overwrite any 
existing files in the above target folder with files of the same name from the archive without 
prompting you for any confirmation to overwrite the file.

· Use stored folder names if any : If this option is checked, PicoZip will restore the original path of 
the files stored in the archive, using the above target folder as the base folder. This is the 
recommended setting. If you do not check this option, PicoZip will extract all files in the archive to 
the above target folder, regardless of any folder names stored in the archive.

Click the Finish button to proceed.



Overwrite Dialog Box

This dialog box is displayed whenever you try to extract a file from an archive to a destination folder that 
already contains a file with the same name. You have the following choices on the action to take:

· Yes : Overwrite the existing file on disk with the file being extracted from the archive.
· Yes    to All : Overwrite the existing file on disk with the file being extracted from the archive, and also 

do this for all other files being extracted in this operation without further prompting.
· No : Skip the extraction of the current file.
· No to All : Skip the extraction of the current file and any other files being extracted in this operation 

which already exist at the destination folder. Files being extracted which does not already exist at the 
destination folder will still be extracted.

· Rename : Allows you to rename the file being extracted.
· Cancel : Aborts the extraction operation for all remaining files.



Using Batch Features

PicoZip comes with many batch features that allows you to carry out archiving related operations on 
many archive files in a single operation. This saves you from having to do time consuming repetitive 
work. 

The batch features can be accessed from the Tools menu. The following are brief descriptions of each 
feature:

· Batch Add to Archive : Use this to add a set of files to many existing archives. Click here to learn 
more.

· Batch Create Archive : Use this when you have many files which you would like to archive 
individually. Click here to learn more.

· Batch Convert Archive Format : Use this to convert many existing archive files with various 
different formats into a single archive format which you choose. Click here to learn more.

· Batch Delete from Archive : Use this to delete file(s) from many existing archives. Click here to 
learn more.

· Batch Extract : Use this to extract files from many existing archives. Each archive is extracted to 
their own subfolder. Click here to learn more.

· Batch Make .EXE : Use this to make self-extracting executables from many existing archives. Click 
here to learn more.

· Batch Test : Use this to test the integrity of many existing archives. Click here to learn more.
· Batch Virus Scan : Use this to scan many existing archives for virus. Click here to learn more.



Batch Add to Archive

Use this to add a set of files to many existing archives. Choose Batch Add to Archive from the Tools 
menu, then follow the steps below:

1. Select the target archive files which you would like to add some files to. Click the Add button to 
choose the files. You can repeat this as many times as necessary to add as many archive files 
as you want. To remove any file from the list, select it, then click the Remove button. Click the 
Next button to proceed.

2. Select files which you would like to add to all the archive files you selected in the previous step. 
The Add and  Remove button works the same as in step 1. In the Add Options, you can set the
following items: Compression - the compression level of files being added. Overwrite files 
without prompting - If you check this option, PicoZip will overwrite any file with the same name 
in the existing archives without prompting you. Save full path info - If you check this option, 
PicoZip will save the full path for the files being added. Click the Next button to proceed.

3. You will be shown the progress window which shows the current status of this batch operation. If
you want to cancel this batch operation, click the Cancel button. Note that canceling a batch 
operation may take a while since PicoZip will complete its current task before stopping. All files 
up to the point you click Cancel  would have been processed completely.

4. Once the batch operation is completed, you will be shown the results screen. You can click on 
the Copy to Clipboard button to copy the results to Windows clipboard, or click the Save to File
button to save the results to a text file. Click the Close button to exit.

If you only want to add files to a single existing archive, read this instead.

Other batch features:
Batch Convert Archive Format, Batch Delete from Archive, Batch Create Archive, Batch Extract, Batch 
Make .EXE, Batch Test, Batch Virus Scan



Batch Create Archive

Use this when you have many files which you would like to archive individually. Choose Batch Create 
Archive  from the Tools menu, then follow the steps below:

1. Select the files which you would like to archive. Click the Add button to choose the files. You can
repeat this as many times as necessary to add as many files as you want. To remove any file 
from the list, select it, then click the Remove button. Please note that each file in this list will be 
archived individually. Click the Next button to proceed.

2. Select the output folder where you want to place the created archive files. If you choose Use the
same folder as the original file, the archive files will be placed in the same folder as the 
original file. If you want all the archive files to be placed in a single folder regardless of where the
original files were located, choose Folder, then enter the full path to that folder. If the path you 
entered does not already exist, PicoZip will automatically create it for you. Click the  Next button 
to proceed.

3. Now, choose the archive format you would like to use. You can also set the following options: 
Delete original file after creating archive - If you check this option, PicoZip will automatically 
delete the original files selected in Step 1 after archiving it. Overwrite files without prompting -
If you check this option, PicoZip will overwrite any existing archive file with the same name 
without prompting you. Click the Next button to proceed.

4. You will be shown the progress window which shows the current status of this batch operation. If
you want to cancel this batch operation, click the Cancel button. Note that canceling a batch 
operation may take a while since PicoZip will complete its current task before stopping. All files 
up to the point you click Cancel  would have been processed completely.

5. Once the batch operation is completed, you will be shown the results screen. You can click on 
the Copy to Clipboard button to copy the results to Windows clipboard, or click the Save to File
button to save the results to a text file. Click the Close button to exit.

If you only want to create a single archive, read this instead.

Other batch features:
Batch Add to Archive, Batch Convert Archive Format, Batch Delete from Archive, Batch Extract, Batch 
Make .EXE, Batch Test, Batch Virus Scan



Batch Convert Archive Format

Use this to convert many existing archive files with various different formats into a single archive format 
which you choose. Choose Batch Convert from the Tools menu, then follow the steps below:

1. Select the existing archive files which you would like to convert. Click the Add button to choose 
the archive files. You can repeat this as many times as necessary to add as many files as you 
want. To remove any file from the list, select it, then click the Remove button. Click the Next 
button to proceed.

2. Select the output folder where you want to place the converted archive files. If you choose Use 
the same folder as the original file, the converted archive files will be placed in the same 
folder as the original file. If you want all the converted archive files to be placed in a single folder 
regardless of where the original files were located, choose Folder, then enter the full path to that
folder. If the path you entered does not already exist, PicoZip will automatically create it for you.  
Click the Next button to proceed.

3. Now, choose the archive format that you would like all the archive files you selected in Step 1 to 
be converted to. You can also set the following options:  Delete original file after creating 
archive - If you check this option, PicoZip will automatically delete the original archive files 
selected in Step 1 after converting it.  Overwrite files without prompting - If you check this 
option, PicoZip will overwrite any existing archive file with the same name without prompting 
you. Click the  Next button to proceed.

4. You will be shown the progress window which shows the current status of this batch operation. If
you want to cancel this batch operation, click the Cancel button. Note that canceling a batch 
operation may take a while since PicoZip will complete its current task before stopping. All files 
up to the point you click Cancel  would have been processed completely.

5. Once the batch operation is completed, you will be shown the results screen. You can click on 
the Copy to Clipboard button to copy the results to Windows clipboard, or click the Save to File
button to save the results to a text file. Click the Close button to exit.

If you only want to convert a single archive, read this instead.

Other batch features:
Batch Add to Archive, Batch Delete from Archive, Batch Create Archive, Batch Extract, Batch 
Make .EXE, Batch Test, Batch Virus Scan



Batch Extract

Use this to extract files from many existing archives. Each archive is extracted to their own subfolder. 
Choose Batch  Extract from the Tools menu, then follow the steps below:

1. Select the archive files which you would like to extract. Click the Add button to choose the files. 
You can repeat this as many times as necessary to add as many files as you want. To remove 
any file from the list, select it, then click the Remove button. Click the Next button to proceed.

2. Select the output folder where you want to place the extracted files. If you choose Use the same
folder as the original file, the extracted files will be placed in the same folder as the original 
file. If you want all the extracted files to be placed in a folder of your choice, choose Folder, then
enter the full path to the target folder. If the path you entered does not already exist, PicoZip will 
automatically create it for you. If you check the Extract each archive to a separate subfolder 
option, the contents of the extracted files will be placed in subfolders within the target folder you 
selected above. If you check the Restore original folders option, any stored folders in all the 
archives will be restored. If you check the Confirm file overwrites option, you will be prompted 
if the destination folder contains a file with the same name as the one being extracted. Click the 
Next button to proceed.

3. You will be shown the progress window which shows the current status of this batch operation. If
you want to cancel this batch operation, click the Cancel button. Note that canceling a batch 
operation may take a while since PicoZip will complete its current task before stopping. All files 
up to the point you click Cancel  would have been processed completely.

4. Once the batch operation is completed, you will be shown the results screen. You can click on 
the Copy to Clipboard button to copy the results to Windows clipboard, or click the Save to File
button to save the results to a text file. Click the Close button to exit.

If you only want to extract files from a single archive, read this instead.

Other batch features:
Batch Add to Archive, Batch Convert Archive Format, Batch Delete from Archive, Batch Create Archive, 
Batch Make .EXE, Batch Test, Batch Virus Scan



Batch Make .EXE

Use this to make self-extracting executables from many existing archives. Choose  Batch Make .EXE 
from the Tools menu, then follow the steps below:

1. Select the existing archive files which you would like convert into self-extracting archives. Click 
the Add button to choose the files. You can repeat this as many times as necessary to add as 
many archive files as you want. To remove any file from the list, select it, then click the Remove 
button. Click the Next button to proceed.

2. Select the output folder where you want to place the self-extracting executable files created in 
this operation. If you choose Use the same folder as the original file, the created self-
extracting executable file will be placed in the same folder as the original archive file. If you want 
all the self-extracting executable files to be placed in a single folder regardless of where the 
original archive files were located, choose Folder, then enter the full path to that folder. If the 
path you entered does not already exist, PicoZip will automatically create it for you. Click the 
Next button to proceed.

3. You will be shown the progress window which shows the current status of this batch operation. If
you want to cancel this batch operation, click the Cancel button. Note that canceling a batch 
operation may take a while since PicoZip will complete its current task before stopping. All files 
up to the point you click Cancel  would have been processed completely.

4. Once the batch operation is completed, you will be shown the results screen. You can click on 
the Copy to Clipboard button to copy the results to Windows clipboard, or click the Save to File
button to save the results to a text file. Click the Close button to exit.

If you only want to make a self-extracting executable from a single archive, read this instead.

Other batch features:
Batch Add to Archive, Batch Convert Archive Format, Batch Delete from Archive, Batch Create Archive, 
Batch Extract, Batch Test, Batch Virus Scan



Batch Test

Use this to test the integrity of many existing archives.  Choose Batch Test from the Tools menu, then 
follow the steps below:

1. Select the archive files that you want to test. Click the Add button to choose the archive files to 
test. You can repeat this as many times as necessary to add as many archive files as you want. 
To remove any file from the list, select it, then click the Remove button. Click the Next button to 
proceed.

2. You will be shown the progress window which shows the current status of this batch operation. If
you want to cancel this batch operation, click the Cancel button. Note that canceling a batch 
operation may take a while since PicoZip will complete its current task before stopping. All files 
up to the point you click Cancel  would have been processed completely.

3. Once the batch operation is completed, you will be shown the results screen. You can click on 
the Copy to Clipboard button to copy the results to Windows clipboard, or click the Save to File
button to save the results to a text file. Click the Close button to exit.

If you only want to test a single archive, read this instead.

Other batch features:
Batch Add to Archive, Batch Convert Archive Format, Batch Delete from Archive, Batch Create Archive, 
Batch Extract, Batch Make .EXE, Batch Virus Scan



Batch Virus Scan

Use this to scan many existing archives for virus. Choose  Batch Virus Scan from the Tools menu, then
follow the steps below:

1. Select the archive files that you want to scan for virus. Click the Add button to choose the 
archive files to scan. You can repeat this as many times as necessary to add as many archive 
files as you want. To remove any file from the list, select it, then click the Remove button. Click 
the  Next button to proceed.

2. You will be shown the progress window which shows the current status of this batch operation. If
you want to cancel this batch operation, click the Cancel button. Note that canceling a batch 
operation may take a while since PicoZip will complete its current task before stopping. All files 
up to the point you click Cancel  would have been processed completely.

3. While the batch virus scan is in progress, you may need to manually close the antivirus program 
after each archive file is scanned. This depends on which antivirus software you use and how it 
was configured.

4. Once the batch operation is completed, you will be shown the results screen. You can click on 
the Copy to Clipboard button to copy the results to Windows clipboard, or click the Save to File
button to save the results to a text file. Click the Close button to exit.

If you only want to scan a single archive for virus, read this instead.

Other batch features:
Batch Add to Archive, Batch Convert Archive Format, Batch Delete from Archive, Batch Create Archive, 
Batch Extract, Batch Make .EXE, Batch Test



Using PicoZip to Email Archive

You can use PicoZip to easily email archives to others. There are two ways to do this:

Have an Existing Archive

If you already have an existing archive, open it in PicoZip, then select Mail Archive from the File menu. 
PicoZip will create a new email message and attach the open archive to it. You can then fill in the other 
details of the email, such as recipient's email address, etc., and send it.

No Existing Archive

If you want to send a bunch of files without having to create an archive first, just select the files in 
Windows Explorer, then right click them. In the popup context menu that appears, there are two menu 
commands that you can use. Compress and Email “Filename.zip” and Compress and Email ....

Compress and Email “Filename.zip” : PicoZip will automatically compress the files you selected into a
temporary archive file, then create a new email message and attach the Zip file to it. You can then 
proceed to fill in the other details of the email, such as recipient's email address, etc., and send it.

Compress and Email ... : Similar to the above, but you will be able to set various options on how you 
want the archive to be created before it is sent.

Note: The email related features in PicoZip uses Simple MAPI (Messaging Application Programming 
Interface) to communicate with your email program. This means your email program must be MAPI 
compliant and properly configured in order for PicoZip to work with it. Examples of MAPI compliant email
programs include: Outlook, Outlook Express, Netscape Messenger and Eudora. 



Rename File Dialog Box

This dialog box is displayed whenever you try to add a file to an archive that already contains a file with 
the same name. You have the following choices on the action to take:

· Rename : PicoZip will rename the EXISTING file in the archive with the new filename you entered, 
then proceed to add the new file to the archive. Click here for an example.

· Skip : Skip adding this file to the archive.
· Skip All : Skip adding this file, and any further duplicate files to the archive in the current operation.



Rename File Example
If you have an archive that contains a file named "Test.txt", and you try to add another new file with the 
same name, the Rename File dialog box will be shown. If you then enter a new file name, say "Test.old" 
and click the Rename button, PicoZip will rename the existing file in the archive from "Test.txt" to 
"Test.old" before proceeding to add the new copy of "Test.txt".



Replace Dialog Box

This dialog box is displayed whenever you try to add a file to an archive that already contains a file with 
the same name, but has a different date, time or size. You have the following choices on the action to 
take:

· Yes : Overwrite the existing file in the archive with with one being added.
· Yes    to All : Overwrite the existing file in the archive with with one being added, and also do this for 

all other files being added in this operation without further prompting.
· No : Skip adding the current file to the archive.
· No to All : Skip adding the current file, as well as any further files with same file names. Files being 

added which does not already exist in the archive will still be added.



Add Options Dialog Box

This dialog box is allows you to specify the location where you want the archive file to be created and the
filename of the new archive file. 

The following options are displayed in the Add Options dialog box :

Archive Type : Choose which archive format you want to use. 

Action - This drop-down list provides 3 choices: 
· Add files : Add all specified files to the archive.
· Freshen existing files : Updates files already in the archive that match the specified files.
· Move files : Same as “Add Files”, but deletes the files after it has been added to the archive.

Compression :  This drop-down list provides 4 choices : Maximum, Normal,    Minimum, None. 
Maximum gives best compression, but takes the longest time to complete. The lesser the compression, 
the faster PicoZip can create the archive. Choosing None means PicoZip will not compress the files 
before adding it to the archive.

Multiple Disk Spanning :  This drop-down list provides 2 choices: Automatic, No Spanning. Selecting 
Automatic means you will be prompted to insert a new disk if the archive file being created cannot fit in 
the current disk. If you select No Spanning, a “disk full” message will be shown if the archive file 
exceeds the space available on the current disk. (This is mainly applicable to removable media)

Password : Click this button to password protect the files that you are about to add to the archive. Click 
here to learn more about this feature.

Save full path info : If you select this option, PicoZip will store the full path from the root folder with all 
files added. 

After setting all the above options, click the OK button to proceed. The archive file will be created and 
displayed in the main PicoZip window.



New Archive Dialog Box

This dialog box is displayed when you choose to create a New Archive. You can now specify the folder 
where you want the archive file to be created, the filename of the new archive file and the archive file 
format. Click the Create button to proceed.

Related Topic:
Add Dialog Box 



Configuring Shell Extensions Tab

You can configure the settings below by clicking on the Shell Extensions tab in the Configuration dialog 
box.

· Enable shell extensions : Unchecking this option will disable all PicoZip shell extensions. We 
highly recommend that you leave this option enabled.

· Cascaded context menu items : If this option is checked, PicoZip will place the context menu items
you checked in the Items to Show in Context Menu section under a sub-menu. If you have many 
items in your context menu, you may want to check this option to reduce clutter.

· Display icons in context menu : If you check this option, PicoZip's icon will be shown next to its 
context menu items. This makes it easier to identify PicoZip's commands.

Items to Show in Context Menu

You can select which PicoZip features you want to show in the Windows Explorer context menu. The 
Explorer context menu is shown when you :

1. Right-click one or more files and/or folders
2. Use your right mouse button to drag and drop one or more archive files in Windows Explorer. 

To see the list of context menu items with explanation of their use, click here.

Default Add Options

· Store Path Info : You can set to store relative or full path when using the “Add to Archive …”, “Add 
to <Filename>”, “Add to <Filename>.EXE” and “Compress and Email <Filename>” context menu 
items.

· Archive Type : The default archive file format used by the “Add to Archive …”, “Add to <Filename>”,
“Add to <Filename>.EXE” and “Compress and Email <Filename>” context menu items.

· Compression : The default compression level used by the “Add to Archive …”, “Add to 
<Filename>”, “Add to <Filename>.EXE” and “Compress and Email <Filename>” context menu items.

Information to Display in InfoTip

PicoZip InfoTips are displayed when you position your mouse cursor over an archive file for about one 
second. The InfoTip can show various information about that archive file, which you can configure in this 
section by checking the required items. 

The Test Area allows you to preview how your configured InfoTip will look like. Just place your mouse 
cursor over the test area for about one second and the InfoTip will be shown.

Other Configuration Topics: 



Toolbar Tab, View Tab, Skin Tab, Folders Tab, File Associations Tab,    Program Locations Tab, Tray Tool 
Tab, Security Tab, Miscellaneous Tab

Related topics:
Using Windows Shell Integration



File Mask
You can use the * and ? wildcards in your file mask. The * wildcard character represents zero, one or 
more characters, while the ? wildcard character represents exactly one character. Examples of file mask:

· *.doc : Selects files with the extension .doc, such as "test.doc" and "manual.doc".
· read*.* : Selects any files that starts with “read”, such as "readme.txt", "ReadFirst.doc", "read.1st", 
"Read.exe"
· db????.xls : Select files with exactly 4 characters between “db” and “.xls”, such as "db1999.xls", 
"dbfast.xls", "db_123.xls"
· setup.exe : Select files with the name “setup.exe”.



Using Backup

PicoZip provides an easy-to-use backup feature that automates most of the work of performing backups.
This is useful when you need to frequently make backups of a set of files and/or folders. In order to 
perform a backup, you need to create a Backup Set first. A Backup Set store all the information 
required to create a backup. After that, to backup this set of files/folder, you only need to run the Backup
Set.

Creating a Backup Set

1. Choose  Manage Backups from the Tools menu. The Manage Backups  dialog box appears. 
Learn more about Manage Backups dialog box.

2. Click the Create button near the bottom. The New Backup Set  dialog box appears.
3. In the New Backup Set dialog box, fill in all the necessary information and set the options for this 

backup set. Click here    to learn more about this dialog box.
4. Click the Save button to save this backup set.

Performing a Backup

Run a Single Backup
If you want to run a single backup, just choose the Backup Set Name from the Tools > Quick Backup 
sub-menu. The backup will be performed and you will be notified when completed. You can also run a 
backup from the Quick Backup sub-menu in the Tray Tool.

Run Many Backups Together
If you want to perform many backups, choose Manage Backups from the Tools menu. In the Manage 
Backups dialog box, check all the Backup Sets you want to backup by clicking on the checkbox beside 
each  Backup Set name. After that, click the Run Backup button. PicoZip will perform backup for all the 
Backup Sets you checked in a single operation. When completed, you will be notified.

Schedule Automated Backups
You can use the scheduling feature in Windows to schedule backups to be performed on a routine basis 
without any user intervention. Click here to learn how.

Related topics:
Manage Backups Dialog Box
Backup Set Dialog Box
Scheduling Backups



Manage Backups Dialog Box

This dialog box allows you to manage your Backup Sets and run many backups at once.

Manage Backup Sets

· Create a New Backup Set : Click the Create button. The New Backup Set dialog box will be 
displayed. 

· Modify a Backup Set : Select a Backup Set from the list  of Backup Sets, then click the Modify 
button. The Edit Backup Set dialog box will be displayed. 

· Remove a Backup Set : Select a Backup Set from the list  of Backup Sets, then click the Remove 
button. You will be prompted for confirmation. Click the Yes button to confirm delete.

Run Many Backups Together

Check all the Backup Sets you want to backup by clicking on the checkbox beside each  Backup Set 
name. After that, click the Run Backup button. All the checked Backup Sets will be backed up in 
sequence.

Tip: If you want to check or uncheck all the backup sets, right click within the Backup Sets list box. A 
popup menu will appear with options to do this in a single click.

View Archives in a Backup Set

You can view the archive file(s) in a Backup Set by selecting a Backup Set, then right click it. A popup 
context menu will be displayed. Select View Archives in Backup Set from the context menu. PicoZip 
will open an Explorer window showing all archive files located in the Backup Storage Folder of the 
selected Backup Set.

Create a Shortcut to a Backup Set On the Desktop

You can create a shortcut on the desktop to run a Backup Set by selecting it, the right click it. A popup 
context menu will be displayed. Select Create Shortcut On Desktop from the context menu. A shortcut 
will now be placed on your Windows desktop. Double-clicking this shortcut will run the Backup Set 
directly without having to run PicoZip first.
 

Copy Command-line to Clipboard

You can copy the command-line required to run a Backup Set by selecting it and then right click it. A 
popup context menu will be displayed. Select Copy Command-line to Clipboard from the context 
menu. You can now paste the command-line anywhere you like. This is useful when you want to perform
backup automatically using Window's scheduling feature, batch files or some other utility.

Related topics:



Using Backup
Backup Set Dialog Box
Scheduling Backups



Backup Set Dialog Box

The Backup Set dialog box allows you to enter all the necessary information to automate a backup. 
Once a backup set is created, you can then run a backup from the Manage Backups dialog box or from 
the Tools > Quick Backup menu. Below are the options you need to set to create a Backup Set.

Backup Options Tab

Backup Set Name : Enter the name for this Backup Set. 

Backup Description : Enter a description for this Backup Set.

Backup Archive File Name : Enter the archive file name that will be used for this Backup Set.

Backup Storage Folder : Select the folder where you want to store the archive files created by this 
Backup Set. WE HIGHLY RECOMMEND that you use a new folder created just for this backup set. If 
possible, try not to use this folder for storing other files. This is to prevent any accidental deletion, etc.

Archive Format : Choose the desired archive format for archive files created by this Backup Set.

Compression : Choose the desired compression level for archive files created by this Backup Set.

Store Path Info : Choose whether to store only the relative path or to store the full path

Password : If you want your backups to be password protected, enter a password here.

Confirmation : You can choose whether to show the confirmation dialog box after performing a backup.
· Within PicoZip :    If checked, a confirmation will be displayed after running a backup from within
PicoZip.
· Direct backup shortcut or command-line : If checked, a confirmation will be displayed after 
running a backup using a shortcut or command-line. 

Backup Method Tab

There are 4 backup methods to choose from:
· Overwrite previous backup :    Every time you backup, PicoZip will use the same filename to 
create the backup archive file and overwrite the existing archive.
· Incremental backup :    The first time you backup, PicoZip will create the backup archive by 
adding all the files/folders you selected. After that, when you run this Backup Set, PicoZip will only 
update the file(s) that has been modified since the last backup.
· Prompt for backup file name : PicoZip will prompt you for the filename to use for backup every
time you make a backup. 
· Multi-generation backup : This method allows you to automatically keep multiple generations 
of backup. Just enter the desired number of generations to keep and PicoZip will do the rest. For 
example, if you have a Backup Set named “TestBak” and you choose Multi-generation backup and 
set it to keep 3 generations. Here is what happens when you do backups:

First time: 
TestBak3.zip created.



Second time: 
TestBak3.zip renamed to TestBak2.zip
New TestBak3.zip created.

Third time: 
TestBak2.zip renamed to TestBak1.zip
TestBak3.zip renamed to TestBak2.zip
New TestBak3.zip created.

Fourth time onwards:
TestBak1.zip DELETED
TestBak2.zip renamed to TestBak1.zip
TestBak3.zip renamed to TestBak2.zip
New TestBak3.zip created.

The latest backup file will always be the one with the highest number appended to its name. 

Files To Backup Tab

Here, you can specify the files and/or folders you would like to backup. Click on Add Files to select files 
to add. If you want to add whole folders, click on the  Add Folders button. You can do this as many 
times as necessary until you have added all the files and/or folders you want to backup in this Backup 
Set. If you want to remove any file or folder, select them from the list and click the Remove button. 

When you add a folder, any files in subfolders within that folder will also be added. If you only want to 
backup the files within that folder without including files in subfolders, just uncheck the checkbox beside 
that folder.

Files To Exclude Tab

Here, you can specify the files to exclude from this Backup Set. This is useful when you want to backup 
everything in a set of folders, but want to exclude certain files or file types. 

You can enter a file name or file mask (wildcards can be used: e.g. *.txt, db??.dat) in the File name/File 
mask field, then press the Add button to add it to the list. To remove any file name or file mask from the 
list, just select it, then press the Remove button.

You can also exclude files with certain attributes from the Backup Set by checking the appropriate option
under Exclude Attributes.

After completing all the necessary information in this dialog box, click the Save button to save this 
Backup Set configuration. Cancel  will close this dialog box without making any changes.

Related topics:
Using Backup
Scheduling Backups
Manage Backups Dialog Box





Register PicoZip

Simple Method

Open the Register PicoZip dialog box by choosing Enter Registration Code from the Help menu. Now, 
open up the email that you received after ordering PicoZip, which contains the registration code. Copy the
whole email to the clipboard, then switch back to PicoZip. You should see that your registration details 
have been automatically filled in for you. Click the Register button to proceed.

Manual Method

Alternatively, you can enter your registration details manually. Open the Register PicoZip dialog box by 
choosing Enter Registration Code from the Help menu. The Register PicoZip dialog box will be shown.
Now, key in the Name and Registration Code EXACTLY as shown in the instructions you received when
you registered PicoZip, then click the Register button. Please note that the Name is case-sensitive, 
and you may NOT use a different name or spelling. In order to prevent typing errors, it is 
recommended that you copy-and-paste the registration information rather than type it.

After registering, the evaluation copy reminder will no longer be displayed every time you start PicoZip. 
The Buy Now button on the toolbar and the Enter Registration Code menu item in the Help menu will 
also be removed.

If you face any problems completing the registration of    PicoZip, you can email us or browse our support 
web site. Click here for contact details.

Unregistered Copy

If you have not paid the registration fee, you may use PicoZip for evaluation purposes only. Click here to 
view the License Agreement. To register, click here for more detail or go directly to our online order form 
at http://www.picozip.com/order.html.

You can click on the Continue Unregistered button to continue evaluating PicoZip, or click the Buy Now 
button to open the online order form in your default web browser.

Related topics:
Awards and Testimonials
Reviews



PicoZip Evaluation Dialog Box

This dialog box is shown every time you start PicoZip only if you have NOT registered PicoZip. To remove
this reminder dialog box, please register PicoZip. 

If you are not ready to register, you can click on the I Agree button to continue evaluating PicoZip. Please 
note that you may use the unregistered evaluation copy for evaluation purposes only. Any other use 
requires the full payment of the registration fee. Click here to learn how to register.

To order online, please make sure you are connected to the Internet, then click the Buy Now button. 
PicoZip will open your default browser and take you directly to the online order form where you can 
purchase PicoZip using credit card, check or by telephone. Your purchase is backed by our 100% risk-
free 30-day money back guarantee.

Related topics:
License
Ordering Information
Register PicoZip Dialog Box



Using Windows Shell Integration

PicoZip is tightly integrated to Windows Explorer to give you quick access to most PicoZip features. Most
of the time, you can perform most archiving tasks directly in Windows Explorer without starting PicoZip. 
Please note that PicoZip shell extensions and file associations must be enabled for this to work (enabled
is the default setting when you first install PicoZip).

Please start Windows Explorer before proceeding with any of the following tasks. Note: You do not need
to run PicoZip before performing any of the following steps.

Opening An Archive

In Windows Explorer, just double click an archive file to open it in PicoZip. Note that PicoZip must be 
associated to archive files for this to work. Click here to learn more.

Viewing Archive Information

In Windows Explorer, you can view information about an archive by simply positioning you mouse cursor
over the archive file for about one second. A small tooltip window will popup to show you information 
such as: number of files in archive, unpacked size, compression ratio and file names of the files in the 
archive. This allows you to quickly get an idea of what the archive contains without having to actually 
open it using PicoZip. 

You can also configure what type of information about an archive to show in the tooltip. Click here to 
learn more.

Explorer Context Menus

Archive Files: 

When you right-click an archive file, you will see the following PicoZip commands in the popup context 
menu. Note that not all commands may be shown at any one time as some are available only for certain 
archive formats : 

· Extract To ... : Extract files in the selected archive to a folder of your choice.
· Extract Here : Extract files in the selected archive to the same folder as the archive file.
· Extract to <Folder> : Extract files in the selected archive to a subfolder within the current folder 

where the archive file is located.
· Scan Archive for Virus : Scan the selected archive file for virus. 
· Convert Archive Format : Convert the selected archive file to a different archive format.
· Test Archive : Test the integrity of the selected archive file.
· Make .EXE File : Convert the selected archive file into a self extracting executable.
· Repair Zip Archive : Repair the currently selected Zip file. 

If you select more than one archive file, you will see the following PicoZip commands:

· Extract Archives Here : Extract the contents of the selected archive files to the current folder.
· Extract Archives To ... : Extract the contents of the selected archive files to a folder of your choice.
· Extract Each Archive to Separate Folders Here : Extract the contents of each archive to a 



separate subfolder in the current folder. 
· Extract Each Archive to Separate Folders To ... : Extract the contents of each archive to a 

separate subfolder in a destination folder of your choice. 

If you use your right mouse button to drag and drop one archive file, you will see the following PicoZip 
commands:

· Extract To ... : Extract the contents of the selected archive to a folder of your choice.
· Extract Here : Extract the contents of the selected archive to the folder where it was dropped.
· Extract To <Folder>\<Filename>\ : Extract the contents of the selected archive to a subfolder in the

folder where it was dropped. 

If you use your right mouse button to drag and drop more than one archive file, you will see the following
PicoZip commands:

· Extract Archives To ... : Extract the contents of the selected archive files to a folder of your choice.
· Extract Archives Here : Extract the contents of the selected archive files to the folder where it was 

dropped.
· Extract Each Archive To Separate Folders Under <Folder>\ : Extract the contents of each archive

to a separate subfolder in the folder where it was dropped.

Non-archive Files: 

When you select one or more non-archive files, you will see the following PicoZip commands in the 
popup context menu: 

· Add to Archive : Add the selected files to a new or existing archive file you specify. You can also 
configure various archive settings.

· Add to <Filename> : Add the selected files to an archive file named <Filename> in the current 
folder.

· Add to <Filename>.EXE : Add the selected files to a self-extracting executable file named 
<Filename>.EXE in the current folder.

· Compress and Email ... : Ask you how you want the archive to be created, then compress the 
selected files and attach it to a new email message. You can then fill in the recipient's details and 
send it.

· Compress and Email <Filename> : Compress the selected files to an archive file named 
<Filename> and attach it to a new email message. You can then fill in the recipient's details and 
send it.

You can configure which commands are shown in the context menu to turn off seldom used commands 
to reduce clutter. Click here for more information.

Drag-and-Drop

To add files to an archive while in Windows Explorer, just drag one or more files and drop it on an 
archive file to add them to the archive.

Related topics:



Configuring Shell Extensions
Configuring File Associations
Quick Start for Windows Explorer Integration



File Associations Dialog Box

If you click the Yes button, PicoZip will associate itself with archive files types that it supports 
(.ace, .arc, .arj, .bh, .cab, .gz, .jar, .lha, .lzh, .rar, .tar, .tgz, .uue, .uu, .xxe, .z, .zip, .zoo). This allow 
Windows to automatically run PicoZip when you double click an archive file in Windows Explorer or My 
Computer. In addition, PicoZip features that are integrated to Windows Explorer are only available to 
associated file types. IT IS HIGHLY RECOMMEND THAT YOU CLICK    YES.

Every time you start PicoZip, it will check whether the file associations have been modified by other 
software. If there has been any modifications, PicoZip will prompt you to re-associate PicoZip to archive 
files. If you do not want to be prompted again, check the Never ask me again checkbox.

Related Topics:
Using Windows Shell Integration



Password Required Dialog Box

This dialog box is shown when you try to perform any operation on an archive that require its contents to 
be extracted, and some or all of the files in the archive is password protected. To proceed, you need to 
enter the password and click OK. If you click Cancel, operations on the current file will be skipped.

You can use the Mask Password option to hide your password while it is being typed. This prevents any 
other people around you who might be looking from finding out your password. 



Awards and Testimonials

Awards Won by PicoZip

User Testimonials

"A very nice zip tool that comes with everything you need and more !"
Review in WebAttack.com

"PicoZip is a powerful tool for working with compressed files, yet it's also easy-to-use. It has support for a 
wide variety of compression formats. At the same time, it makes it easy to generate self-extracting files 
and do regular backups. PicoZip can convert from one format to another, integrate with email, and 
process batches of files. So, if you're looking for a program for working with compressed files, take a good
look at PicoZip -- very well done!"
Michael E. Callahan aka Dr. File Finder (tm)
DRFF.com

"Hey man, even the advanced features are simple to understand and use. This is one program made to 
make your life much, much easier."
Dave's Review
DaveCentral.com

"PicoZip is cheaper and even better than many well known zip utilities."
Nicolás H. Martins
Chairman of WindowPlanet.net

"Makes WinZip look a little outdated! PicoZip is super quick and seemlessly provides all of my archiving 
needs - superb effort !!!"
Shaun McGill
Founder of ClieWorld.co.uk

"PicoZip really kicks butt! I uninstalled all 3 compression utilities I had before and just use PicoZip now."
Michael Klucher
Founder of PDArcade.com

"PicoZip is fantastic !! It is robust, fast and simple, but still full of advanced features"
Campbell Mander
Founder of aFreeGo.com

"I have to say that I love it. It's taken over from WinRAR as my zipper of choice, hands down."
Wil Harris



PR Executive of Bit-Tech.net

"PicoZip is loaded with features that make it the ultimate compression utility."
Jason Fontenot
Founder of UtilityGeek.com

"This file compression tool is more user friendly than Winzip, WinRar and WinAce put together. ... I will 
never use another file compression utility."
Brian Minca
Founder of YourSWS.com

Related topics:
PicoZip Reviews
Competitive Comparison



File Viewer Selection Dialog Box

You can choose how to view the file(s) you selected.

· Associated Program : Open the file using its associated program.

· External Viewer : Open the file using the external viewer that you configured.

Clicking the Cancel button will abort viewing of the file(s) you selected.



PicoZip Reviews

The following are reviews of PicoZip published by independent publications. You can see more reviews 
on our website by clicking here.

"PicoZip packs lots of user-friendly features that make it a joy to use. ... This is a complete file 
compression and backup solution in one application. ... If you don’t already have a file compression utility,
I’d really give serious consideration to PicoZip. I’m certain you’ll be as pleasantly surprised as I was."
- WUGNET (Windows Users Group Network)

"PicoZip offers a convenient Explorer-style window, showing you all the archive files in the highlighted 
directory and displaying the contents in a separate pane; much easier than browsing all files, picking out 
the one you need from non-archive file types and then opening it in an entirely separate window. Favorite 
organization is head and shoulders above the competition as well, which comes in handy for those of us 
who compress lots of files."
- LockerGnome

"Novices will love how easy this program is to use. The wizard will guide you through each process. If you
run into any trouble you can always open up the help file. Hey man, even the advanced features are 
simple to understand and use. This is one program made to make your life much, much easier. It's got 
integrated e-mail support and batch operations that'll help make repetitive tasks quick and painless. Heck,
you can even set it up to handle routine backups automatically!"
- DaveCentral

"You owe it to yourself, if you aren’t using PicoZip already, to give it a spin. I stress the point that I 
seriously doubt you’ll be disappointed. Some compression apps just aren’t worth buying because most 
have alternatives that are free. Well, PicoZip has stability and features that you will just not be able to find 
in a freely produced utility. A big kudos to Acubix for producing an excellent grade product!"
- UtilityGeek.com

"This file compression tool is more user friendly than Winzip, WinRar and WinAce put together. ... I will 
never use another file compression utility. PicoZip has outdone some of the best utilities out there. Why 
would you download and install all those different programs, when PicoZip will do it all, and then some. 
PicoZip really is the best way to manage Zip files."
- YourSWS.com

"PicoZip is a great program, it has a clean interface, and incorporates a lot of options not seen in other 
archive programs. The ability to access more than one archive format is key since people do not want to 
download more than one program to open a different archive format. ... This program is filled with a lot of 
great features and for those who do backup their files on a regular basis, would be thrilled by what 
PicoZip has to offer"
- TheSoftwareCorner.com

Related topics:
Awards and Testimonials
Competitive Comparison



Configuring Tray Tool Tab

You can configure the settings below by clicking on the Tray Tool tab in the Configuration dialog box.

Enable tray tool : If this item is checked, PicoZip Tray Tool is automatically started everytime Windows 
is started. PicoZip Tray Tool places an icon in your Windows tray area to provide you with quick access 
to various PicoZip features.

Double-click Tray Icon Action

You can select which action to perform by default when you double-click PicoZip's tray icon:

· Show PicoZip : Open PicoZip
· Show Wizard :  Open PicoZip Wizard
· Show Manage Backup Window : Show Manage Backup dialog box

Recent Files List

Check the Show list of recently opened archives in tray icon menu option if you want PicoZip to 
display the list of most recently opened archives in the popup menu that is shown when you right-click 
PicoZip tray icon. 

You can also choose how this list is formatted by selecting the appropriate option under List Format. 

· Show file name only : Only show the archive file name
· Show full path :  Show the full path to the archive

Other Configuration Topics: 
Toolbar Tab, Skin Tab, View Tab, Folders Tab, Shell Extensions Tab, File Associations Tab,    Program 
Locations Tab, Security Tab, Miscellaneous Tab



Using Tray Tool

PicoZip Tray Tool is a separate program from PicoZip that runs in the background when Windows is 
started. You access it through the PicoZip icon that is placed in the Windows tray area on the task bar. 

Double-clicking on the icon will open PicoZip by default, but you can configure it to perform other tasks. 

Right-clicking the icon will popup a menu with the following items:

· Recently Opened Archives : A list of recently opened archive files are displayed at the top. Clicking 
on any of these will run PicoZip and display the selected archive.

· Quick Backup :  A list of existing Backup Sets    are shown in a submenu below this item. You can 
click on any of these to run the selected Backup Set.

· Manage Backup : Show Manage Backup dialog box where you can configure the Backup Sets.

· Open PicoZip :  Runs PicoZip

· Configure :  Show PicoZip configuration dialog box.

· Help :  Open PicoZip help file. 

· About :  Display general information about PicoZip, such as version, copyright, etc.

· Exit :  Open PicoZip Wizard

Related topic:
Configure Tray Tool



Find Dialog Box

The following options are displayed in the Find dialog box:

File Name to find : Enter the filename you want to search for. You can use * and ? wildcard characters in 
your search string. The * wildcard character represents zero, one or more characters, while the ? wildcard
character represents exactly one character.

Date

· Any Date : Matches any file date.
· Files with dates on or between : You can select a range of dates. To change the date, click on the 

down-arrow button beside the date field. You can also click on the day, month or year section of the 
date field, then press the UP or DOWN arrow key on your keyboard to change it.

Unpacked Size

· Any Size : Matches any file size.
· Files with size : You can enter the file size in kilobytes, and type of comparison to be performed.

After setting any of the above options, click the Find button to perform the search. The first file in the 
currently opened archive matching your criteria will be highlighted. To find more files using the same 
criteria, press the F3 key, or select Find Next from the Edit menu.



Edit Menu

The following commands are available on the Edit menu:

· Select All: Select all files in the currently open archive.

· Deselect All: Deselect all files in the currently open archive.

· Invert Selection: Reverse the selected and unselected file status in the currently open archive.

· Select Group: Select all files matching a file mask provided by you.

· Deselect Group: Deselect all files matching a file mask provided by you.

· Find: Find files in the currently opened archive based on the criteria you set. See Find Dialog Box 
for more info.

· Find Next: Find the next file that meets the criteria you set in the Find command.

Other Menus:
File, View, Actions, Favorites, Tools, Options, Help



PicoZip Recovery Tool

Selecting the Recover ZIP Password menu item in the Tools menu will run PicoZip Recovery Tool. If you
have a Zip or self-extracting Zip archive open, it will be automatically passed on to PicoZip Recovery Tool.

PicoZip Recovery Tool is an easy-to-use FREE add-on program for PicoZip that can help you recover 
lost or forgotten passwords from password protected Zip files. Self-extracting Zip files are also supported. 
If you have not installed PicoZip Recovery Tool, you can download it here ( http://www.picozip.com/prt ).

This program supports two methods of password recovery:

· Brute Force method : The encrypted file is tested with all possible permutations of a range of 
characters that you select. This method is time consuming for long passwords, but can ensure that 
all possible passwords are tested.

· Dictionary method : The encrypted file is tested with all words obtained from a dictionary file. Using
a dictionary file that contains    650,000 words, it should only take a few seconds to test all the words.
This method is very fast, but will only work if a common word was used to password protect the file. 
We would recommend that you try this recovery method first before resorting to Brute Force method.

To learn how to use PicoZip Recovery Tool,    please read the help file that came with it. 



Competitive Comparison

The following is a feature comparison between PicoZip 2.0 and WinZip 8.0. 

Features PicoZip 3.0 WinZip 9.0

Supported extract archive formats 18 10

Supported create archive formats 7 1

Self-extracting archive formats 8 0

Export file list formats 3 0

Features accesible from explorer context menu 23 14

Batch features to perform archiving tasks like add, create, convert, virus scan, 
etc. on many archives in a single operation.

Yes No

Support strong 128/256-bit AES encryption Yes Yes

Full featured automated backup tool Yes No

Built-in explorer Yes No

Wizard Yes Yes

Virus scan Yes Yes

Convert archive format Yes No

Repair damaged Zip archive Yes No

All context menu items configurable Yes No

Split ZIP files Yes Yes

Check out Yes Yes

Install from archive Yes Yes

View/Run files in archive Yes Yes

File filter Yes No

Select/Deselect group of files Yes No

Windows integration (Shell extensions) Yes Yes



Drag-and-drop support Yes Yes

Email support Yes Yes

Test integrity of archive Yes Yes

UUencode/XXencode Yes Yes

Most-recently-used folders list for Extract Yes No

Related Topics:
Awards and Testimonials
Reviews



Drop Add Options Dialog Box

This dialog box is allows you to set the add options for files that you drag-and-dropped on an existing 
archive. 

The following options are displayed in the Add Options dialog box :

Action - This drop-down list provides 3 choices: 
· Add files : Add all drag-and-dropped files to the archive.
· Freshen existing files : Updates files already in the archive that match the drag-and-dropped files.
· Move files : Same as “Add Files”, but deletes the files after it has been added to the archive.

Compression : This drop-down list provides 4 choices : Maximum, Normal,    Minimum, None. 
Maximum gives best compression, but takes the longest time to complete. The lesser the compression, 
the faster PicoZip can create the archive. Choosing None means PicoZip will not compress the files 
before adding it to the archive.

Password : Click this button to password protect the files that you are about to add to the archive. 
Click here to learn more about this feature.

Save full path info : If you select this option, PicoZip will store the full path from the root folder with all 
files added. 

After setting all the above options, click the Add button to proceed. 



Compress and Email Options Dialog Box

This dialog box is allows you to set options on how you want your archive file to be created before it is 
attached to an email, ready to be send.

The following options are displayed in the Compress and Email Options dialog box :

Archive File Name : Enter the filename for this archive file.

Archive Type : Select the archive format that you wish to use.

Compression : This drop-down list provides 4 choices : Maximum, Normal,    Minimum, None. 
Maximum gives best compression, but takes the longest time to complete. The lesser the compression, 
the faster PicoZip can create the archive. Choosing None means PicoZip will not compress the files 
before adding it to the archive.

Password : Click this button to password protect the files that you are about to add to the archive. 
Click here to learn more about this feature.

Save full path info : If you select this option, PicoZip will store the full path from the root folder with all 
files added. 

After setting all the above options, click the OK button to proceed. 

Related topics:
Using PicoZip to Email Archive



Scheduling Backups

You can schedule backups to be run automatically at specific times on a routine basis (daily, weekly, etc) 
by using the scheduling facilities provided by Windows. Below are step-by-step instructions on how to do 
this.

Windows 2000/XP

1. Run PicoZip, then select Manage Backups from the Tools menu.
2. In the "Manage Backups" dialog box, select the Backup Set that you wish to schedule, then right

click it. In the popup context menu that appears, select Copy Command-line to Clipboard. You
can now close this window by clicking Close, then exit PicoZip.

3. Select Start Menu > Programs > Accessories > System Tools > Scheduled Tasks.
4. Double click on Add Scheduled Task. Click Next.
5. In the "Scheduled Task Wizard" dialog box, select "PicoZip". Click Next.
6. Enter a name for this task, and select how often you would like to perform this task. Click Next.
7. Fill in any required scheduling information. Click Next.
8. Enter your user name and password (check with your system admin if you are not sure). Click 

Next.
9. Check the Open advanced properties for this task when I click Finish option, then click 

Finish.
10. In the Run field, delete everything in this field, then paste from clipboard by right-clicking this 

field, and select Paste from the popup context menu. You should see the PicoZip command-line 
pasted into this field. Click OK.

Windows 98/ME

1. Run PicoZip, then select Manage Backups from the Tools menu.
2. In the "Manage Backups" dialog box, select the Backup Set that you wish to schedule, then right

click it. In the popup context menu that appears, select Copy Command-line to Clipboard. You
can now close this window by clicking Close, then exit PicoZip.

3. Select Start Menu > Programs > Accessories > System Tools > Scheduled Tasks.
4. Double click on Add Scheduled Task. Click Next.
5. In the "Scheduled Task Wizard" dialog box, select "PicoZip". Click Next.
6. Enter a name for this task, and select how often you would like to perform this task. Click Next.
7. Fill in any required scheduling information. Click Next.
8. Check the Open advanced properties for this task when I click Finish option, then click 

Finish.
9. In the Run field, delete everything in this field, then paste from clipboard by right-clicking this 

field, and select Paste from the popup context menu. You should see the PicoZip command-line 
pasted into this field. Click OK.

Windows 95

Windows 95 does not provide any built-in scheduling feature.

Related Topics:
Using Backup
Backup Set Dialog Box
Manage Backups Dialog Box





Split Zip Archive

This feature allows you to split a large Zip archive into several smaller files. This is useful when you have
a Zip archive file that you would like to store in a removable media like floppy disk, but is too large to fit 
in a single disk.

To split an archive, first open the archive you would like to split. After that, choose Split Archive from the
Actions menu. The Split Archive dialog box appears. You can set the following parameters:

· Save split archive file as    : Enter the filename that you would like to use for the split archive file.
· Split volume size : Select a size for the split volumes. If you would like to specify a custom size, 

select "Other Size" from the list.
· Custom volume size : Enter a custom volume size. You should also select the appropriate size type

(bytes, kilobytes or megabytes)..

Click on the Split button after setting the above parameters. A dialog box will inform you when the archive
has been successfully splitted.



Configuring Skin Tab

A skin is a set of files containing images that will replace the standard toolbar button icons. Changing the 
skin allows you to customize the look of your PicoZip.

You can configure the settings below by clicking on the Skin tab in the Configuration dialog box. 

Use default toolbar skin : If this item is checked, PicoZip will use the built-in skin for the toolbar buttons. 
To use a different skin, you need to uncheck this item.

List of installed skins : Select the toolbar skin that you would like to use from this list. You can see how 
a particular skin looks like by clicking on it. 

Installing a New Skin

Click the Add button, then select the Zip file containing the skin. If the file you selected contains a valid 
toolbar skin, it will be added to the list of installed skins. To download new skins or learn how to create 
your own custom skin, visit our website at http://www.picozip.com/skin/.

Removing an Installed Skin

Select the skin you wish to remove, then click the Remove button. When ask to confirm the removal, click
Yes.

Other Configuration Topics: 
View Tab, Toolbar Tab, Folders Tab, Shell Extensions Tab, File Associations Tab, Program Locations Tab,
Tray Tool Tab, Security Tab, Miscellaneous Tab



Batch Delete from Archive

Use this to delete one or more files from many existing archives. Choose Batch Delete from Archive 
from the Tools menu, then follow the steps below:

1. Select the target archive files from which you would like to delete some files. Click the Add 
button to choose the files. You can repeat this as many times as necessary to add as many 
archive files as you want. To remove any file from the list, select it, then click the Remove 
button. Click the Next button to proceed.

2. Enter specific file names to delete specific files from within the previously selected archives in 
Step 1, or enter file masks (e.g. *.txt, *.tmp) to delete all files matching the mask. Click the Add 
button to add the file name/mask you just entered to the list. You can add as many file 
names/masks as you like. Click the Next button to proceed. Warning: This is an operation that
could potentially destroy a lot of data, so you will be prompted for confirmation on 
whether to proceed. If you are sure you know what you are doing, click the YES button to 
proceed.

3. You will be shown the progress window which shows the current status of this batch operation. If
you want to cancel this batch operation, click the Cancel button. Note that canceling a batch 
operation may take a while since PicoZip will complete its current task before stopping. All files 
up to the point you click Cancel  would have been processed completely.

4. Once the batch operation is completed, you will be shown the results screen. You can click on 
the Copy to Clipboard button to copy the results to Windows clipboard, or click the Save to File
button to save the results to a text file. Click the Close button to exit.

If you only want to delete files from a single existing archive, read this instead.

Other batch features:
Batch Add to Archive, Batch Convert Archive Format, Batch Create Archive, Batch Extract, Batch 
Make .EXE, Batch Test, Batch Virus Scan



Unsafe File Type

The Unsafe File Type dialog box will appear when you try to open or run certain types of files that could 
potentially cause problems on your computer. This extra precaution is necessary due to an increase in 
worms or viruses that tries to bypass antivirus scanners and spread by sending themselves in 
compressed archive files as email attachments.

Unsafe File Type Dialog Box
This dialog box gives you options on what action to take when trying to open/run an unsafe file type. If 
you are sure that the file you tried to open can be trusted, click YES to continue to open/run the file. If you
are not sure whether the file can be trusted, click    NO to stop PicoZip from opening/running the file.

If you often work with certain file types that are in our list of unsafe file types, and you are certain that you 
will not receive archives from untrusted sources containing those file types, you can stop PicoZip from 
displaying the Unsafe File Type dialog box in the future by checking the Check to disable future 
warnings for this file type checkbox near the botom of this dialog box. 

You can also configure unsafe file type warnings in the security configuration settings.

Unsafe File Types List 
The following is the list of file types that is considered unsafe by default in PicoZip. This list is compiled 
from the list provided by Microsoft and other security organizations:
AD, ADE, ADP, APP, ASX, BAS, BAT, CHM, CMD, COM, CPL, CRT, CSH, DLL, EXE, FXP, HLP, HTA, INF, INS, ISP, 
JS, JSE, KSH, LNK, MDA, MDB, MDE, MDT, MDW, MDZ, MSC, MSI, MSP,MST, OCX, OPS, PCD, PIF, PRF, PRG, 
REG, SCF, SCR, SCT, SHB, SHS, URL, VB, VBE, VBS, VBX, VSD, VST, VSS, VSW, WS, WSC, WSF, WSH, XSL

Safe Computing Practices
These days, there are many viruses or worms that spread via email attachments, instant messaging, 
peer-to-peer networks, etc. The best way to avoid from being accidentally infected is to avoid 
opening/running files from unknown/untrusted sources. You should also keep your antivirus software up-
to-date so that if you really do have to open/run files from unknown/untrusted sources, at least your 
antivirus software can scan it for the latest known viruses/worms.

Related topics:
Security Configuration



Configuring Security Tab

You can configure the settings below by clicking on the Security tab in the Configuration dialog box.

Enable warning for unsafe file types : If this item is checked, PicoZip will display a warning message 
when you try to open/run an unsafe file type, and give you the option to proceed or abort. 

Unsafe File Types List : This is the list of file types that are considered unsafe by PicoZip. You can 
disable warning message for any file type in the list by unchecking it. Clicking Check All button will check 
all file types, while Uncheck All button will uncheck all file types.

Other Configuration Topics: 
View Tab, Toolbar Tab, Folders Tab, Skin Tab, Shell Extensions Tab, File Associations Tab,    Program 
Locations Tab, Tray Tool Tab, Miscellaneous Tab






